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Chapter
Manipulating Data

The robust features of InfoAssist+ enable you to perform such tasks as joining data or
blending data. In environments where additional data sources may be utilized or
combined, you can use the functionality in this section to manipulate your data and data
source.

In particular, you may have data sources that you want to join with another data source.
Optionally, you may want to blend the data in another data source with your data source.
Both of these features enable you to create larger, more customized data sets for
reporting, and charting, or for creating visualizations.

In this section, we describe and discuss the concepts of data manipulation, including
Defines, Computes, Joins, Blends, and filtering options.

In this chapter:

.d  Missing Data in a Chart
Adding and Switching Data Sources
Setting the Source of Your Data
Creating Virtual Fields in Web Query

d

d

d

. Joining and Blending Data
.d  Using Filters to Customize the Display of Data
d

Output Formats

Missing Data in a Chart

When working with charts, you can use the options for missing data to control the display of
values that are missing in a chart.

Note: This option is disabled for reports.

Procedure: How to Specify an Option for Missing Data
1. Create a chart with at least one measure and one dimension.

2. On the Data tab, in the Display group, click Missing Data.
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Adding and Switching Data Sources

3. On the menu that displays, select one of the following options:
- Gap. Displays missing values as a gap in bar, line, and area charts.

- Zero. Displays a bar on the zero line in a bar chart. Displays a solid line that connects
the missing value with the succeeding value in a line chart. Displays an area on the
zero line in an area chart.

- Interpolated Line. Displays missing values as an interpolated dotted line that connects
the plot points preceding and succeeding the missing value in a line chart. Displays
missing values as an interpolated bar in a bar chart. Displays missing values as an
area in an area chart.

Your chart displays based on the option you selected.

Adding and Switching Data Sources

Procedure:

When working in Document mode, you can add an additional data source. Once you have
multiple data sources available, you can then switch between them. These options are on the
Data tab, in the Data Source group. The ability to switch data sources is particularly useful in
Document mode, as you may often switch between a report and a chart.

Note: The Data Source group is not available when working with Reporting Objects.

How to Add and Switch Data Sources

1. Open InfoAssist+ in Document mode.

2. Add a report or chart.

3. On the Data tab, in the Data Source group, click Add.

4. In the Open dialog box, select a Master File and click Open.

This option allows you to add additional data sources to a document, enabling you to
insert reports from different data sources into the same document. The Resources panel
refreshes with the newly selected data source.

5. Click Switch to select from the available data sources.

This option opens a drop-down list of all the data sources that have been added. You can
choose which data source is currently active and being used to create new reports. You
can also switch data sources by selecting a report that is using a data source that is
different from the one that is currently active. The Resources panel will reflect the
structure of the data source that you choose.
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1. Manipulating Data I

Setting the Source of Your Data

You can preview your data using sample data, or data directly from the source that you have
selected. You can also set the number of rows that should be retrieved from the data source
when Live Preview is selected.

Note: In Live Preview, an exclamation point is placed next to fields that are too large to be
displayed within the space allotted. The allotted space is determined by the page-level styling.
Page-level styling includes page size, orientation, margins, and font size.

Content that fits or is displayed on a page depends on the font used and its size. Margins,
gaps, and page elements, such as headers and footers, also determine how much material is
displayed on a page.

Procedure: How to Set the Source of Your Data
1. Create a report, chart, or document using data from an available Master File (.mas).

2. On the Home tab, in the Design group, click Use Sample Data.

Your report or chart displays using sample data, which reduces processing time by
eliminating the need to access the actual data source.

3. Click Data from Source to use the data source that you originally selected.

InfoAssist+ uses the selected data source to display a live preview of the output on the
canvas.

4. Optionally, enter a number of rows or click the drop-down menu for Records, where you
can set the number of rows to be retrieved from the data source when Live Preview is
selected. The default is 500, but other preset choices include: All rows, 1, 10, 50, 100,
500, 1000, 2000, 5000, and 10000.

Note: If you are working with a large amount of data, this feature is useful in reducing
response time.

Creating Virtual Fields in Web Query

A temporary field is a field whose value is not stored in the data source, but can be calculated
from the data that is there, or assigned an absolute value. A temporary field takes up no
storage space in the data source, and is created only when needed. DEFINE fields and
COMPUTE fields are two different types of temporary fields.

When you create a temporary field, you determine its value by writing an expression. You can
combine fields, constants, and operators in an expression to produce a single value. For
example, if your data contains salary and deduction amounts, you can calculate the ratio of
deductions to salaries using the following expression: deduction / salary.

Db2 Web Query InfoAssist+ Part 2 9



Creating Virtual Fields in Web Query

You can specify the expression yourself, or you can use one of the many supplied functions
that perform specific calculations or manipulations. In addition, you can use expressions and
functions as building blocks for more complex expressions, as well as use one temporary field
to evaluate another.

Note: When creating a DEFINE or a COMPUTE field, the following characters are suppressed
and cannot be entered in the Format text box.
space | "#$ &' ()*+,/1;<=>?2@[\] _"{|}~

Selecting a Temporary Field

The following information is provided to help you choose the kind of temporary field that you
need.

1 Choose a virtual field when you want to:

- Use the temporary field to select data for your report. You cannot use a calculated
value, since it is evaluated after data selection takes place.

- Use the temporary field to sort on data values. A calculated value is evaluated after the
data is sorted. With the BY TOTAL phrase, you can sort on this type of field.

1 Choose a calculated value when you want to:

- Evaluate the temporary field using total values or prefix operators (which operate on
total values). You cannot use a virtual field, since it is evaluated before any totaling
takes place.

d Evaluate the temporary field using fields from different paths in the data structure. You
cannot use a virtual field, since it is evaluated before the relationship between data in
the different paths is established.

Detail (DEFINE)

10

A virtual field (DEFINE) is evaluated as each record that meets the selection criteria is retried
from the data source. The result of the expression is treated as though it were a real field
stored in the data source.

The calculation that determines the value of a virtual field is performed on each retrieved
record that passes any screening conditions on real fields.

You can define a virtual field in the following ways:

-1 In a Master File. These virtual fields are available whenever the data source is used for
reporting. These fields cannot be cleared by JOIN or DEFINE FILE commands.
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1. Manipulating Data I

- In a procedure. A virtual field created in a procedure lasts only for that procedure.

A DEFINE field is an optional attribute used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data source (that is, from permanent
fields).

You may define fields simultaneously (in addition to fields defined in the Master File) for as
many data sources as desired. The total length of all virtual fields and real fields cannot
exceed 32,000 characters.

The Detail Field (DEFINE) dialog box allows you to create a defined field, type a name for the
field, and enter a format.

The Detail (DEFINE) dialog box is shown in the following image.

. B Detail Field (DEFINE) o x
= Rinefine 1] ! Format D122 g E- El- & '
Search fields 2
= U wf_retail_lite
+ Query Variables
=l Measures
£ Sales
+ Shipments
=l Dimensions
+ Sales_Related
= Product
| 2 & - 9 2 + Shipment_Related
I < = 4 5 5 + Store
+ Customer
IF = + * 1 2 3
THEN AND OR 0
ELSE NOT = 0 " u .

(S Cancel

Summary (COMPUTE)

A calculated value (COMPUTE) is evaluated after all of the data that meets the selection
criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the
aggregated values of the fields. Calculated values are available only for the specified report
request. You specify the COMPUTE command in the body of the report request, following the
display command and optionally, introduced by AND. You can compute more than one field
with a single COMPUTE command.

The Summary Field (COMPUTE) dialog box allows you to create a computed field, type a name
for the field, and enter a format.

Db2 Web Query InfoAssist+ Part 2 11



Creating Virtual Fields in Web Query

The Field List provides similar functionality, including options to display data source fields in a
Logical, List, or Structured view. You can also view a complete set of functions, instead of data

source fields, by clicking the Functions button J&
The Summary (COMPUTE) dialog box is shown in the following image.

3 Summary Field (COMPUTE)

o
*

Field  Compute_1 | Format ||D122 @ E- BE- &-

Search fields

o

= g wf_retail_lite
+ Query Variables
= Meaasures

£ Sales
+ Shipments
=l Dimensions
+ Sales_Related
® Product
I = = - 4 9 £ + Shipment_Related
I < = - 4 5 6 3l Store
+ Customer
IF = 2 * 1 2 3
THEN AND OR 0
ELSE NOT s 0 " u

3

() Cancel

Using Field Titles in a Define or Compute

When working with Defines and Computes, field titles automatically display as you build your
criteria in the Define (or Compute) text area.

Field titles are an attribute of a field. They are defined in the metadata and display only when
specified for the field that you select. If a field title has not been defined in the metadata, the
title that displays will be the physical field name.
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1. Manipulating Data I

The Use field titles feature enables you to see the field title (for example, Cost of Goods)
rather than the fully qualified name of the field (for example,
WF_RETAIL_LITE.WF_RETAIL_SALES.COGS_US). This facilitates easy identification of field
names while building your Define or Compute. You can switch between the display of field
titles and fully qualified field names by unchecking the Use field titles option, which you can
access by clicking Additional Options, as shown in the following image.

B Detail Field (DEFINE)

Field |Define_1

"Cost of Goods”

!
|
IF
THEN

ELSE
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AND

NOT

v

OR

=%

Format Diz.2

Search fields
= P wf_re
Query

O x
@ B~ Fl- @ v
Additional Options P

W NSIU UuSs

Preserve null value

Missing Values 3

=l Meas
Sales
Shipments
=l Dimensions
Sales_Related
Product
g £ Shipment_Related
5 6 Store
Customer
2 3
u

»

" OK (S Cancel
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Creating Virtual Fields in Web Query

If your Define or Compute uses more than one field with the same title (for example,
Sale,Year), then only the first field will be added using field titles. Any other reference to this
identical field will use the fully qualified field name. For example, in a sample InfoAssist+ data
source, Sale,Year displays as the field title for two unique fields:
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR and
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_DATE_YEAR_COMPONENT. In this case, only
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR would display (using field titles) as
Sale,Year. The other field would display using the fully qualified field name, as shown in the
following image.

B Detail Field (DEFINE)

O x
Field Define_1 Format || Di2.2 g E- E]l- [& '
ye)

"Sale,Year” Search fields
WF_RETAIL_LITE.WF_RETAIL_TIME_SALES. TIME_YEAR_COMPONENT —
22 Quantity, Sold -
2l Revenue Local Currency

2 Revenue

g%, Sale Unit(s)

g& Revenue Per,5q. Ft.

5&, Revenue Local Per 5Q. M.

+ Shipments
= Dimensions
l : z N 7 8 & = Sales_Related
| = = - 4 5 g = Transaction Date, Simple
Sale, Year

r - - : 0 5 3 # Sale,Quarter

THEN || AND or 0 it Solc,Month
* Sale,Day .

ELSE NOT = 0 " u - r ma @

3

" OK &) Cancel

Note: When reviewing a procedure (.fex) that contains Define or Compute code, field names
always display as fully qualified field names, not field titles.

Procedure: How to Use Field Titles in a Define or Compute

14

1. In Report or Chart mode, create a Define or a Compute.
2. Add fields by double-clicking them in the metadata tree.

Note: The fields that you select display with field titles, as this is the default option. If you
specify a field with a duplicate field title, the fully qualified field name is used for the
second (and any subsequent) instance.

3. Click Additional Options and then click Use field titles to disable the use of field titles,
which results in the display of fields using the fully qualified field name.
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1. Manipulating Data I

Resizing the Text Area of a Define or Compute

When working with Defines and Computes, you can adjust the width of the text area to
accommodate the size of the fields in your query. This is particularly useful if you are using
fully qualified names or long formulas, which can span more than the standard width of the
text area.

In its original state, the text area is aligned with the calculator, as shown in the following
image.

A Detail Field (DEFINE)
Field :’m ® Format ||D12.2 ‘32' @ - El- @ - ﬁ__
o

Search fields
= T @ wi_retail_lite
Query Variables
=l Measures
Sales
Shipments
= Dimensions
Sales_Related

Product
| < = - 7 8 9 Shipments_Related
+
i . . a : z [# Store
Customer
IF = = = 1 2 3
THEN AND OR ! 0
ELSE NOT = - u
0 < >

& Cancel
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Creating Virtual Fields in Web Query

When fully expanded, the text area removes the metadata tree and toolbar from view, as
shown in the following image.

B Detail Field (DEFINE)

Field :Dm x Format || D12.2
< > + 7 8 :
| = = 4 5 6
- - : . 1 2 3
THEN AND OR ! 0
ELSE NOT = 0 u

(S Cancel

Procedure: How to Resize the Text Area of a Define or Compute
1. Open InfoAssist+ in Report or Chart mode.
2. Select a Master File.

3. On the Data tab, click Detail (Define) or Summary (Compute).
The Define or Compute dialog box displays, respectively.

Hover over the right border of the text area until double arrows display.
Click and drag the field to the right.

The text area is resized.
Note:

. If you expand the text area in a current session, InfoAssist+ will retain that expanded
state for use in other areas of the application. For example, if you expand the text area
when creating a Define, the expanded state will be present when you create a
Compute.

. When working with the text area in an expanded state, you can reinstate the metadata
tree and toolbar by hovering over the right border of the text area until double arrows
displays. Click and drag the arrows to the left and right, as needed.
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1. Manipulating Data I

Creating Temporary Fields Independent of a Master File

The temporary fields that you create with the DEFINE and COMPUTE commands are tied to a
specific Master File, and in the case of values calculated with the COMPUTE command, to a
specific request. However, you can create temporary fields that are independent of either a
Master File or a request using the DEFINE FUNCTION command.

A DEFINE function is a named group of calculations that use any number of input values and
produce a return value. When calling a DEFINE function, you must first define the function.

A DEFINE function can be called in most of the same situations that are valid for Information
Builders-supplied functions. Data types are defined with each argument. When substituting
values for these arguments, the format must match the defined format. Alphanumeric
arguments shorter than the specified format are padded with blanks, while longer
alphanumeric arguments are truncated.

All calculations within the function are done in double precision. Format conversions occur only
across equal signs (=) in the assignments that define temporary fields.

Enabling the Display of Missing Values for a DEFINE or COMPUTE

When working with DEFINEs and COMPUTESs, you can use the Missing Values option to enable
or disable the display of missing values for a DEFINE or COMPUTE field. This allows you to
accurately display missing values in reports, charts, and visualizations. The Missing Values
option, which is accessible through the Additional Options button, is shown in the following
image.

O x
@ B- E- @ ,
Use field titles o

.
Preserve null value

Missing Values 3 Off
LT REvene On

& 5ale Unit(s) On Al
E&; Revenue Per,5q. Ft

The following descriptions explain each option on the Missing Values drop-down list:

. Off. When selected, MISSING syntax is removed from the DEFINE or COMPUTE field
definition. This is the default selection. MISSING treats missing values for numeric fields
as zeros and missing values for alphanumeric fields as blanks.

1 On. When selected, MISSING ON is added after the format in the DEFINE or COMPUTE field
definition. MISSING ON interprets the temporary field as missing.
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Joining and Blending Data

-1 On All. When selected, MISSING ON ALL is added after the format in the DEFINE or
COMPUTE field definition. MISSING ON ALL indicates that if all fields in the expression have
values, then the temporary field has a value. If at least one field in the expression has a
missing value, the temporary field also has a missing value.

Joining and Blending Data

Joins

18

You can join two or more related data sources to create a larger integrated data structure from
which you can report in a single request. The joined structure is virtual. It is a way of accessing
multiple data sources as if they were a single data source. This can greatly increase the
number of fields available for use in your content, giving you an expanded selection for your
reporting and charting purposes.

Using conditional joins, you can establish joins based on conditions other than equality
between fields. In addition, the host and cross-referenced join fields do not have to contain
matching formats, and the cross-referenced field does not have to be indexed.

Note: You can edit the description of a join by clicking Edit in the Join dialog box and typing in
the Description section. You can only use letters, numbers, and underscores in your
description. No special characters are allowed.

The conditional join is supported for all relational data adapters. Because each data source
differs in its ability to handle complex conditional criteria, the optimization of the WHERE
syntax differs depending on the specific data sources involved in the join and the complexity of
the conditional criteria.

For data sources, if the host and cross-referenced join fields do not have common matching
formats, the following message appears.

Where-Based Join

The total length of host fields should
q_*/ match the length of the target field!

Do you want to create a Where-
Based join?

Yes Mo

Note: If you click Yes, the Filter dialog box opens, where you can create a Where-Based Join.
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1. Manipulating Data I

If the cross-referenced join field does not have an index, the following message appears.

Where-Based Join

D] Target field is not indexed!

-
-
) Do you want to create a Where-

Based join?

Mo

Note: If you click Yes, the Filter dialog box opens, where you can create a where-based join.

To create a where-based join, create a filtering condition.

Blending Data

The blend option allows you to explicitly select the data fields that you want to include. More
specifically, you can join multi-fact data structures and combine pertinent external data into
your current data source, creating a blended data resource. This can be from local or other
system resources.

Blending is used to create customized data sources. For example, you may have some of the
basic fields available in the current data source, but you can use the blend option to add
relevant data fields from a different data source to the current data source in order to create a
unique data set.

The blend option allows a new fact table to be added to a cluster master as a parent segment
to an existing child segment. This option is available from the Join dialog box. You may want to
blend data if you are reporting from two different fact tables that share a common dimension,
such as a product dimension. For an example of this, you can view the sample retail database,
wf_retail_lite. The wf_retail_lite Master File contains the WF_RETAIL_STORE_SALES segment
and the WF_RETAIL_SALES segment. The WF_RETAIL_SALES segment is defined as the parent
of the WF_RETAIL_STORE_SALES segment. You may want to add a second fact table to the
report. The second fact table in this example will be an Excel spreadsheet that you upload to
InfoAssist+ for use with a report or chart. The data in the spreadsheet file that you upload will
be joined to the wf_retail_lite database using a common field.

Note: You can find supported, common fields in your selected database (for example,
wf_retail_lite) using the search feature in the Data pane. If necessary, you may need to add a
field in your spreadsheet to map your data to the structure of the database. For example,
ID_CUSTOMER. In addition, the name of the primary sheet in Microsoft Excel becomes the
name of your data source, so be sure to name the file accordingly.
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Joining and Blending Data

Procedure:

20

The following list provides some general rules that apply to the Blend option:

1. The result of blending is that a single dimension is shared between two fact tables. The

table must be based on a cluster with at least two segments. One segment is for Fact table

1, the second segment is for the dimension.

2. Two uploaded files cannot be blended because they result in single segment Master Files.

3. Do not use the fields from the blended table as a sort field, since these fields will not have

a common field when used with fields from other fact tables.

How to Blend Data

This procedure describes how to blend data from an external data source into an existing data

source. This example uses a Microsoft Excel spreadsheet file.
1. On the Data tab, in the Join group, click Join.
The Join dialog box displays.
2. Click Add New.
The Open dialog box displays.
Note: The options that display on the Open dialog box depend on your user privileges.
3. At the top of the Open dialog box, click Upload Data.

The Upload wizard opens.

4. Drag your Microsoft Excel spreadsheet file on to the Upload pane, or click Select Upload

File to locate the file on your local drive.

The next screen of the Upload wizard opens. You can use the options on this screen to

preview and change spreadsheets and delimited data files before you upload them to the

target environment. This screen shows you the default breakdown of your data as
measures, dimensions, and hierarchies.

5. On the ribbon, click Load and Next.

The Target Load Options dialog box opens.

Note: By default, the Bulk Load check box is selected. Clear this check box if you do not
have a bulk load program that supports your target environment. For example, if you are

using Microsoft SQL Server, you may use a Bulk Copy Program (BCP). If you are unsure

about whether you have a bulk load program installed, contact your system Administrator.

6. Click Proceed to Load.

The Upload wizard closes, and you return to the Open dialog box.
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Note: If there are informational messages or if your upload is unsuccessful, the Status
screen opens.

In the Open dialog box, click the name of your uploaded data source and then click Open.

8. In the Join dialog box, create a connection between the common fields by dragging your
mouse pointer from the field in the Master File to the common field in the newly uploaded
file.

9. Click Blend, and then click OK.

The blended data source fields are now available in the Data pane.

Using Filters to Customize the Display of Data

Filters enable you to customize the display of data in your report, chart, document, or
visualization. This gives you the advantage of viewing only the data that you want to see and
use.

When creating a report, you refer to fields in several parts of the request. For example, in
display commands (PRINT, SUM), in sort phrases (BY, ACROSS), and in selection criteria
(WHERE, WHERE TOTAL, IF).

Note: When using ESSBASE hierarchical data sources, creating a filter on a sort field is not
supported.

The WHERE phrase selects records from the data source to be included in a report. The data is
evaluated according to the selection criteria before it is retrieved from the data source. You
can use as many WHERE phrases as necessary to define your selection criteria.

In WHERE TOTAL tests, however, data is selected after all the data has been retrieved and
processed.

You can group conditions and expressions within filter criteria. In addition, you can apply
functions and calculations within criteria. For more information on filtering options, see Field
Tab.

You can create Where and Where Total filters in the Filter dialog box by clicking WHERE.

Db2 Web Query InfoAssist+ Part 2 21



Using Filters to Customize the Display of Data

Double-clicking the Double-click or press F2 to edit! text opens drop-down menus for Fields and
Subqueries, Operators, and Values, as shown in the second image to follow.

H Create a filtering condition O x
oF New Fitter  JIF New Expression

K| F O
= ¥ WHERE
Double-click or press F2 to edit!

" 0K (8 Cancel
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You can retrieve fields and values from the Master File and data source and Subqueries from a

HOLD file.
ir Create a filtering condition o x
J.r:? New Filter =a? Mew Expression ,,r Insert Before ‘z‘]nserl After o Group
X ¥ @
= ¥ WHERE
Equal to <Value>
Type: ; Field ,
retail | Field
E Subtfry -
Search fields §el

= T g wf_retail_lite
Query Variables
1=l Measures
Sales
Shipments
=l Dimensions

Sales_Related -
k

oK (8 Cancel i
< S " OK (S Cancel
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The Field drop-down menu provides a field list from the Master File. The Field list can be

viewed as follows:
I In business order (default)
I".? Create a filtering condition
oF tew Filter  JIF New Expression
X ¥

= ¥ WHERE
freis

qual to <Valuex
Type: Field
il

amples/wf_retail_lite
El - (sl -

7 view fields in business order
Searur megs

= T wf_retail_lite
Query Variables
= Measures
Sales
Shipments
[= Dimensions
Sales_Related

0K
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AF Insert Before

W Insert After & Group

]

%) Cancel
S 0K

& Cancel
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I In a sortable grid

Er Create a filtering condition O x
4}? New Filter 4}! Mew Expression J Insert Before '!lnsert After s Group
N
X ¥ O
= F WHERE

i«Field= = Equal to <Value>

Type: Field -

= - Bl &l -
Search fields. View fields in & sortable grid o~
Mame Title Alias

S EUROPEAN_UMION  Store,Eur
S CONTINENTAL_UNITE Store,Cor
S EUROPEAN_UNION | Customer
S CONTINENTAL_UNITE Customer
% STORE_PROMPT Store Mar

S WEB_STORE Web Stor -
3
oK (8 Cancel ;
v © Cance W DK (8 Cancel
I In a hierarchical structure of the data
ir Create a filtering condition O Xx
oF ew Filter  JF New Expression ) Insert Before "W Insert After | o Group
X ¥ D
= ¥ WHERE
Type: Field -
retail_samples/wf_retail_lite
= - E- &
N ™ View the hierarchical structure of the data
Search fields >
= éwf_retail_lite
(= Sales Fact
3 1D Sales
B 1D Store
B 1D Currency
g 1D Customer
g 1D Discount -
3
oK (8 Cancel _
v © cance " OK (8 Cancel

I If you select Subquery, then the Operator drop-down menu is replaced by a menu with the
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options of In list and Not in list, as shown in the following image.

H Create a filtering condition O x
“1;}? Mew Filter =:.'? Mew Expression ,r Insert Before ':Insert After o Group
X # O “
= ¥ WHERE
Subquery (I

it <Subauery>

Mot in list

0K () Cancel

Note: The Subquery option is not available in the Filter dialog box if you are creating a
report from a Reporting Object.

. In list. Activates a drop-down menu in the right-most part of the expression. The drop-
down menu contains a list of all subqueries that you have created from the Master File
in use, and an EXISTING option.

Click EXISTING to open the Open dialog box, where you can select a subquery from a
different Master File.

d Not in list. Opens the Open dialog box, where you can select a subquery from a
different Master File.

The Operator (default) drop-down menu provides various operators for your filter. For example,
Equal to.
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The Value drop-down menu opens a dialog box with multiple options, as shown in the following

image.
J Create a filtering condition O x
,&!New Filter 4! Mews Expression ; Insert Before 'KInsert After o Group & Ungroup
= ¥ WHERE
Product,Category Equal to
Type: | Constant -:
Value: Multiple Values: - v %X

3E Get Values -

Search values 2

o OK - (§) Cancel

Note: If you are creating a filter on a full date field, the Value field will have a calendar icon
adjacent to it. You can use this icon to select a date using a calendar control.

The Type drop-down menu contains the following options:

.d Constant. Enables the entry of a literal value. This value can be a positive number, a
negative number, or any character string.

.d Parameter. Enables you to specify a parameter by entering a name and description in the
provided text input areas, as well as selecting the type of parameter (Simple, Static, or
Dynamic).

Note: If you create a filter that specifies a simple parameter, QUOTEDSTRING will be
inserted at the end of the line that defines the simple parameter, as specified in the
procedure (.fex), by default. In this case, when you run a .fex that contains this value, you
will not be able to enter multiple values, at run time, for simple parameters.
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You can also select Optional to set the parameter as optional. This adds the default value
of _FOC_NULL, which removes the parameter from the procedure. Indicating Optional also
disables the prompt for parameters functionality within the procedure. Therefore, if a report
has an optional parameter, it would run without any prompting. However, if another report
drilled down to it, the parameter would be accepted and it would run with that value. The
Optional option is used primarily for other reports that would be drilling down to the current
report and passing the parameter to this report. For more information, see Using Multi Drill
and Using the Auto Linking Feature to Link Content.

When defining WHERE clauses in the Create a filtering condition dialog box, you can also
create simple, static, and dynamic parameters. These parameter values are transformed
into local variables that allow the content of your report to be defined at runtime by a
context in your data or a selection by the user. Additionally, you can change to scope of this
parameter amper variable from local to a global scope so that its value is available across
multiple components on a page or in a document. To transform the parameter to have
global scope, enter a single & (amper) symbol in the first character position of the
parameter name field.

Note: The & symbol can only be entered in the first position of the parameter name where
it defines the parameter scope. Parameter field names cannot contain a & symbol in any
other character position.

The parameter options are shown in the following image.

Type: | Parameter -
Mame: PRODUCT_CATEGORY Description:| Preduct Category:
* Simpls Static Dynamic
Optional
" OK (8 Cancel

d Field. Enables the specification of a field name to compare against.

The value area generally contains a text input box that you can use to manually insert values.
However, if you are working with a date field, the Value field is set to Today. You can optionally
select Beginning of Month, End of Month, Beginning of Quarter, End of Quarter, Beginning of
Year, End of Year, or you can specify a Custom date using the calendar that displays when you
make that selection.
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Note: The default date of Today applies to Report, Chart, and Document modes only.

The value area also contains a Get Values drop-down menu, which supplies the following
options:

All. Retrieves all the values from the selected field.

First. Retrieves the first value from the selected field.

Last. Retrieves the last value from the selected field.
Minimum. Retrieves the minimum value from the selected field.

Maximum. Retrieves the maximum value from the selected field.

L U o o o u

From File. Retrieves a value that you specify. Selecting this option opens the Select From
File dialog box, where you can browse to a local file and specify a file format, such as a flat
file (CSV) or an Excel spreadsheet (XLS or XLSX).

Numeric data values can be imported into the available filter values from a flat file or a CSV
as pure numbers. This import supports humbers containing leading signs (negative),
numeric digits, and decimal points. Numbers containing currency symbols or commas will
be imported but as shown in the Values box in the Create a filtering condition dialog box,
may not be interpreted correctly. Text or CSV files with values requiring complex formatting
can be opened and saved with the appropriate formatting in Excel. This Excel file can then
be imported with the formatting retained.

Note: The Get Values drop-down menu is only accessible if you have already selected a field.
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Once you have retrieved the values for your filter using one of the Get Values options, you can
use the Search values option to quickly locate a record in the list. For example, you can type in
the letter S to go to that section in the list. Also known as type ahead search, this functionality
can bring you directly to the value that you want to include, making it easy to identify the
required values. Wildcards, such as an asterisk, are also supported. The Search values option
is shown in the following image.

T\’rpe: Constant -

Multiple Values: "y * X

>

3 Get Values~

IS-:—ar:h values 2 I

Accessories

Camcorder

Computers

Media Player

Stereo Systems

Televisions

Video Production @

" 0K (§) Cancel

After selecting the values that you want, you can move them into and out of the Multiple
Values area with the left and right arrows. You can also change the value order and delete
values with the up and down arrows and the Delete icon.

After creating a condition, you can insert additional conditions before and after the selected
condition by using the Insert Before and Insert After buttons at the top of the Filter dialog box.
You can use either the And or the Or conjunction to link conditions and the Group and Ungroup
buttons to nest and organize conditions.

You can also add an expression to your filter by clicking the New Expression button. This
creates a new WHERE clause and allows you to build an expression dynamically.
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You can create additional filters by clicking the New Filter button at the top of the Filter dialog
box.

After creating the filters that you want, click OK to save and apply the filters. You can access
them from the Filter pane of the Resources panel.

Note: Dates shown in the live preview reflect the format specified in the data source. However,
when Filters are applied to a date formatted field, the format of dates shown in the Filter
interface is derived from the locale. When the report, chart, or visualization is executed, the
output, as well as any prompt will reflect the format specified in the data source.

Including or Excluding a Filter

Once you have created a filter, you can make decisions about when and where you want to
include it in your report. For example, you might want to include one filter and exclude another.
Using the Include and Exclude options in the Filter group on the Home or Field tabs, you can
set filters accordingly.

You can use the following information to make decisions about your filters:
4 Exclude. Removes, but does not delete, the filter from the report.

d Include. Restores a filter that was previously excluded from a report.

Using the Prompt Functionality to Select Field Information at Run Time

Using the prompt functionality, you can create an auto prompting parameter for which you can
define a value at run time. This feature is located in the Filter Group on the Field tab.

To create an auto prompting parameter:
1. Select a field for which you want to create a parameter in your report.
2. On the Field tab, in the Filter group, click Prompt.
The Create a filtering condition dialog box displays.
3. Double-click the Value field.
Note: Parameter is selected, by default, when you are defining a prompt.

The following options display, from which you can make a selection:
.4 Simple. This is used for prompts using Text Input. This is the default value.

- Static. This is used for prompts using Selection. This option allows you to select
multiple values at run time.
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-1 Dynamic. This is used for prompts using Data Values. This option allows you to select
multiple values at run time.

Note: You can also select Optional to indicate that the selected value (Simple, Static, or
Dynamic) is optional.

Click OK, and click OK again to close the Create a filtering condition dialog box.

When you run your report, you will be prompted for information based on the parameters
you created.

Output Formats

You can change your output format on the Home tab, in the Format group.

. Current Output Format. Displays a drop-down menu of all supported output formats.

32

4 HTML (the default for charts and reports)
4 HTML5 (only available for charts)

- active report (default for documents)
PDF

active PDF

Excel (xIsx) (reports designed in Live Preview and Query Design views only)

L U o U

Excel Formula (xlIsx) (reports designed in Live Preview and Query Design views only)

Note: You can control the display of Excel output formats from the InfoAssist+
Properties section in the >Report Broker Administration Console.

. PowerPoint (pptx)

When you run a report, the output is created in the format that is currently selected. You
can also select output format options on the status bar, from the Output Types menu.

Report or Chart. Determines whether report-specific or chart-specific functionality is
available in the InfoAssist+ tool. The default name ReportX or ChartY is given for each new
report or chart created in a given InfoAssist+ session. X and Y are numbers that start at 1
and increase by 1 for each report or chart created. For more information on switching
between multiple reports, see View Tab.

File. Creates an image file from a chart, or a data file from a report. For more information,
see Output Formats for Reports and Charts on page 38.
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Format Reports Charts Documents

HTML Available Available Available
(default) (default)

HTML5 Not Available Available Not Available

active Report Available Available Available

PDF Available Available Available

(document default)

active PDF Available Available Available

(requires Adobe®

Reader® 9.0 or

later)

Excel formats Available Available Available

PowerPoint (pptx) | Available Available Available

PDF/GIF Not Available Available Not Available

(must be set to

display in

InfoAssist+

Properties)

PNG Not Available Available Not Available

(must be set to

display in

InfoAssist+

Properties)

GIF Not Available Available Not Available

(must be set to

display in

InfoAssist+

Properties)
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HTML5

Format Reports Charts Documents

JPEG Not Available Available Not Available
(must be set to
display in
InfoAssist+
Properties)

SVG Not Available Available Not Available
(must be set to
display in
InfoAssist+
Properties)

HTMLD5 is the default output format for charts. It allows you to render a chart in the browser
using a built-in JavaScript engine. Charts with this output format utilize the very latest
capabilities of the HTML5 web standard, including animation, high-quality vector output, and
attractive alpha-channel and gradient effects.

Enabling Additional Output Types

34

The output types of PNG, GIF, JPEG, and SVG do not appear on the status bar, in the Output
Types menu, by default. In addition, User Selection is not available, by default. You can enable
these options by opening the Administration Console, selecting Utilities, and then InfoAssist+
Properties.

If these formats are not enabled and you try to open an existing procedure with PNG, then
HTML becomes the output. In addition, the following warning messages could open:

4 When opening an existing procedure with JPEG, GIF, or SVG, a warning message opens,
indicating that the request is not allowed with the current configuration and that the
procedure will be converted to HTML output.

.4 When opening an existing procedure with PDF or GIF, a warning message opens, stating
that the request is not allowed with the current configuration and that the procedure will be
converted to PDF output.

When you run a report, the output is created in the format that is currently selected. You can
also set output format options from the output format button in the status bar.
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User Selection

The User Selection output format allows you to change the output type of your report at run
time. User Selection can be accessed on the status bar, in the Output Types menu.

Note: User Selection must be enabled in the Administration Console in order to access the
functionality.

Once it is enabled, you are prompted, at run time, to select an output type. This is shown in
the following image.

HTML

You can select one of the following output types for your report, chart, or document:

.4 For reports, you can select HTML, active report, PDF, active PDF, Excel (xIsx), Excel Formula
(xIsx), and PowerPoint (pptx).

.4 For charts, you can select HTML, HTML5, active report, PDF, active PDF, Excel (xIsx), and
PowerPoint (pptx).

Note: When working with charts that do not employ the new chart attribute syntax, all
output formats will display when User Selection is selected. If you are working with a chart
that uses the new chart attribute syntax, HTML5 and active report are the only output
formats available for selection. Exceptions to this rule are the HTML5 specific charts that
do not use the new attribute syntax, but are only available in HTML5 or active formats,
including: Tagcloud, Parabox, Mekko, and Streamgraph.

4 For documents, you can select HTML, active report, PDF, active PDF, Excel (xIsx), and
PowerPoint (pptx).
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Chapter
Creating HOLD Files

A HOLD file is the output of a report request stored in a file that you can use as input to
another >Report Broker procedure.

You can then create new report requests that extract data from the HOLD file, resulting
in a multi-step report.

HOLD files can be created to use in a report, chart, document, or visualization.

In this chapter:

.4 Valuable Applications of HOLD Files

.4 Storing HOLD Files

- Output Formats for Reports and Charts
4 Creating HOLD Files
d

Creating a Subquery Filter Using a HOLD File

Valuable Applications of HOLD Files

A HOLD file is valuable when you want to do the following;:

.4 Extract fields from a large data source for faster and more efficient retrieval in subsequent
requests. This reduces processing time, enabling you to create reports and charts rapidly
against a smaller, more specialized data set. This improves efficiency while giving you the
flexibility that you need when working with smaller subsets of your data.

- Store virtual field values or summary values calculated in one request for further processing
in another request. This allows you to reuse calculated values, decreasing the effort
required to recreate certain scenarios.

Storing HOLD Files

HOLD files can be created for immediate use and saved temporarily or they can be stored for
future and repeated use. This gives you the flexibility to use and store HOLD files, as needed,
based on how you want to use the files that you create.
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Output Formats for Reports and Charts

You can save a HOLD file for a report in the following formats:

Binary (*.ftm)

FOCUS (*.foc). For more information, see FOCUS Format Index Fields on page 47.
Comma Delimited with Titles (*.csv)

Plain Text (*.ftm)

Tab Delimited (*.tab)

Tab Delimited with Titles (*.tab)

L U U U U U oL

Database Table (*.sql)

Note: The Database Table output is only available when working against an SQL database.

L

SQL Script (*.sql)
- Hyperstage (*.bht)

Note: The Hyperstage output is only available when the reporting server has a Hyperstage
adapter configuration.

- XML (*.xml)

- JSON (*.json)

You can save a HOLD file for a chart in the following formats:
- PNG (*.png)

o GIF (*.gif)

4 SVG (*.svg)

- JPEG (*.jpg)

Creating HOLD Files

This section contains examples of how you would use a HOLD file.

Note:

- Across fields are not allowed in HOLD files.
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Using the Change Title option in the Query pane, you can change the title of a field prior to
creating a HOLD file. A blank space in the title will be replaced by an underscore. This
functionality enables you to control the names used for the fields included in the HOLD file,
and makes it easier to find the fields when creating a report, chart, or document.

When creating a HOLD file, the Temporary dialog box displays only those reporting server
applications to which you have access.

You can use Auto Linking when working with HOLD files. For more information, see Using
the Auto Linking Feature to Link Content.

When working with charts in HTML5 format, you cannot create a HOLD file. You can do so,
however, in HTML format.

When a report contains a HOLD procedure, dots or periods (.) in the AS name of the Define
field are automatically converted to an underscore (_).

Procedure: How to Create Multiple Components in a Document From a HOLD File

This procedure describes how to extract fields into a HOLD file and then create multiple
components in a document from the HOLD file.

8.
9.

T L T S

Open InfoAssist+ in Document mode.

Select a data source.

Add fields that need to be extracted for use in subsequent requests.
On the Home tab, in the Format group, click FileFile & Printer.

Click the Destination drop down list and select File.

Click the Browse button to open the Temporary dialog box.

In the Temporary dialog box, name the file, choose the format of the HOLD file from the
format drop-down list, and click Save.

Note: The default is to create a temporary HOLD file, which is deleted after the report or
chart is run. Alternatively, you can create a permanent HOLD file by selecting an
application path folder location. This file will remain in this location after the procedure is
run for future use.

On the Insert tab, in the Reports group, click Chart.
Add fields to the chart.

10. Insert another chart.
11. Add fields to that chart.
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12. On the Format tab, in the Chart Types group, click Pie.

13. On the Insert tab, in the Reports group, click Report.

14. Add fields to the report.

15. Add as many reports and charts as you want to complete your document.

How to Create a Tabular Report From a HOLD File

To create a tabular report from a HOLD file, begin by creating a report.

1.
2.

In the Open dialog box, select the wf_retail_lite Master File.

Add the following measure fields to the report:
- Cost of Goods

- Discount

- Gross Profit

- Quantity,Sold

- Revenue

Add the following dimension fields to the report:
- Product Category
- Product,SubCategory

- Sale,Year
On the Home tab, in the Format group, click File.
The Temporary dialog box opens.

In the Temporary dialog box, hame the HOLD file, keep the default file type, Binary (*.ftm),
and click Save.

At the bottom of the canvas, click Create Report.

The custom database structure displays in the Resources panel. The canvas is returned to
a default blank state, enabling the development of a new report using the HOLD file.

From the HOLD file, drag Quantity,Sold to the canvas.

On the canvas, select the Quantity,Sold column heading.

On the Field tab, in the Display group, click Aggregation, and then click First Value.
Note: The heading changes to FST Quantity Sold.
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10.
11.

12.
13.

14.
15.
16.
17.

18.
19.
20.

Select the FST Quantity Sold heading.

On the Field tab, in the Display group, click Hide Field to hide Quantity,Sold, as it will be

used in a subsequent calculation.
On the Data tab, in the Calculation group, click Summary (Compute).
In the Summary Field (COMPUTE) dialog box, do the following:

- In the Format field, type D8.2%.
.4 Double-click the Quantity,Sold field to add it to the formula box.
d Add / 100 after the Quantity Sold field to calculate the percentage.

The following image is an example of the Summary Field (COMPUTE) dialog.

[m]
®

3 Summary Field (COMPUTE)

Format | D8.2% g =- El- & -
Search fields
= [ #Filel
=l Measures
2 Cost of Goods

2 Discount

Field | Compute_i

o]

"Quantity,5old" [ 100

2 Gross Profit
2] Quantity,Sold
2 Revenue

=l Dimensions

l = * - b 8 5 G Product,Category
| = = 4 5 6 S Product, Subcategory
G Sale,Year
IF = = 2 1 2 3
THEN AND OR ! 0
ELSE NOT e 0 " U

4

" OK (S Cancel

Click OK to close the dialog box.
Drag Product,Category to the By Query field container.
In the Query pane, select the Product,Category field.

On the Field tab, in the Break group, select Subtotal to create Subtotals on
Product,Category.

Drag Product, Subcategory to the By Query field container.
Drag Sale,Year to Across.

On the Home tab, in the Report group, click Row Totals.

The final report displays.
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Procedure: How to Create a HOLD File for a Subquery
The following procedure describes how to create a HOLD file for use in a subquery.

1. Create a new report with at least one filter condition set.

@QI@ [ R~
r Home Format Data Slicers Layout  View a e
[ Lil] Chart % Data from Source & z Exclude =
&) . Erres @ <] =) Use Sample Data Y >
HTML %,Fﬂe RPrinter - Query Prl::ri;! Document Records: 500 ~  Filter Repo
Format I Design Filter
- 3§ Data i Live Preview (500 Records)
£ ID_MARITAL_STATUS o ol
£ First Name =l
£ Last Name
£ Gender 000001
& Customer Full Name I 000002
= &g Measures/Properties ‘E‘ 000004
& Customers 000015
T 000016
— ¥ Filter LI
000018
:’ Gender Equal to Female 000021
000024
— 000025
- B Quev 000028
= [E) Report (WF_RETAIL_CUSTOMER) 000031
% sum 000033
= Esy 000034
B ID_CUSTOMER 000041
= Across 000045
000046
000047
000043 -

2. Click FileFile & Printer.

The FileFile & Printer button is found on the Home tab, in the Format group, and on the
Format tab, in the Destination group.

The FileFile & Printer button is a split button. Click the left side of the button to launch the
Temporary dialog box. The down arrow on the right side also opens the Save dialog box so
you can change settings or set them for the first time.

The Select a location and formatTemporary dialog box opens.

Note: The label Temporary appears at the top of the dialog box. When you select a folder,
the label changes to Select a location and format.
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The File & Printer Options dialog box opens, as shown in the following image.

2, File & Printer Options =
Destination:  File -
File Mame: Topnis
" OK () Cancel

3. Click the Destination drop down list and select File, then click the Browse button.
In the Select a location and format dialog box, provide the following:
a. Inthe File name text box, type a file name.
The default file name is Filel.
b. From the list menu, select SQL Script (*.sql) as the file format.
c. Select a location for the HOLD file.

The location is either Temporary, which is the default, or a writable server application
folder.

Note: If the HOLD file name already exists in the specified location, it will be
overwritten without warning, when you click Save.

5. Click Save.

The Create Report button appears on the bottom of the InfoAssist+ Live Preview
application window.

6. Repeat steps 2 - 4 to create as many HOLD files as you need.

To use the HOLD file right away, select the corresponding option.

Note: When you are working with a report created from a HOLD file, if you try to switch
data sources, or add data sources to the report, you are presented with warning
messages.

Procedure: How to Rearrange HOLD File Components

The following procedure describes how to rearrange file components in a HOLD file.
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Note: This procedure creates a binary HOLD file and a subquery to illustrate how to rearrange
HOLD files. It also shows the result of this rearrangement.

1. Create a new document, using the wf_retail_lite Master File for the data source.

2. On the Insert tab, in the Reports group, click Report. Populate the report with the following
fields from the Data pane:

Gross Profit

Quantity,Sold

Product,Category

1
1
4 Revenue
1
d

Product,Subcate

gory

The report is shown in the following image.

Duh-“«? a8

Home | Insert | Format Data Slic

al &

= Run ~

ers  Layout  View

E

Page Chart Existing Text Image
Report Box
Pages Reports Objects
3 Data - wi_retail_lite =) Query
Search fields £ 4 E|Reportl (wf_retail_lit=)
Query variables 4 X sum
4 Measures B Gross Profit
4 Sales B Quantity,Sold
3 Cost of Goods,Local Curre B Revenue
2 Cost of Goods 4 =y
2 Discount,Local Currency 8 Produd, Category
2 Discount B Product,Subcategory

2 Gross Profit,Local Currenc & A
& Gross Profit
2 MsRP,Local Currency
i msrp
2 Quantity, Sold
2 Revenue,Local Currency
2 Revenue
B, sale Unit(s)
B, Revenue Per,Sq. Ft.
B, Revenue Local Per 5Q. M.
Shipments
4 Dimensions
Sales_Related
4 Froduct
3 Product,Category
77 Producs Subcategory
7% Model
Values
Shipment_Related
Store

¥ Filter

Customer

= - 2 pocument

ross
ordinated

=

Drop
Down

o

List Checkbox

® =
Radia Text
Button

Active Dashboard Prompts

[ Document

o

&

[ Page1~

I

Product
Category
Accessories

Camcorder

Computers

Wedia Player

Stereo Systems

Televisions

Video Production

Product

Subcategory

Charger

Headphones

Universal Remote Controls
Handheld

Professional

Standard

Smartphone

Tablet

Blu Ray

DVD Players

DVD Players - Portable
Streaming

Boom Box

Home Theater Systems
Receivers

Speaker Kits

iPod Docking Station
CRT TV

Flat Panel TV

Portable TV

Video Ediing

Gross Profit
$1,970,123.01
$24,523,023.97
$13,361,292 65
$21,393 654 97
$8,835,522.75
$19,369,667.52
$15,834,702.15
$17,674, 11597
§51,771,195.13
$1,859,645.81
$265150.77
$1,938 586 65
$546,423 99
$27,931,096.22
$16,555,835 56
$25,819,241 69
$15,328,473.06
$602,419.65
$15,885,498 71
$342 105 45
$17,947,619.62

Quantity
Sold
105,257
228,349
178,061
250,167
12,872
192,205
205,049
146,728
679,495
18,835
5,694
87,910
9370
399,092
150,568
244,199
311,103
45633
92,501
3,049
199,749

Revenue
54022834 91
$76,186,587.97
$49,398 91565
$41970,570.97
$44,053,830.75
$68,441,300.52
$59,670,476.15
$43 445 005 97
$232,384 116 13
$5,615,899.81
857172877
§7,001,316 85
51,386,796 99
584,359 685 22
$56,885,503 56
$107,215,381.69
$41,447,566.06
$2,530,835.65
$74,962,843 71
5887453 45
$58,053,276.62

3. On the Home tab, in the Format group, click File to create a HOLD file.

In the Temporary dialog box, enter a name for the file. For example, Filel_binary.

4. Click Save.
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5. Create a report using the HOLD file, specifying Product,Category, Product,Subcategory, and
Quantity,Sold, as shown in the following image.

E] Query [ Document
a ] Files [ (T - - -
a Filel_binary (wf_retail_lite) |
a [E) reportt (Filel_binary) 1 n
4 X Sum E Product Product Quantity
B Quantity,Sald ] Category Subcategory Sold
4 =By 1] Accessories Charger 105,257
B Product,Category B Headphones 228,349
_— jRidd SIS0 ] Universal Remote Controls 178,061
= Across 1 Camcorder Handheld 250,167
IE Coordinated
1 Professional 12,872
2 Standard 192,205
] Computers Smartphone 205,049
4 Tablet 146,728
] Media Player Elu Ray 879,495
5 DVD Players 18,835
B M DVD Players - Portable 5694 "
] Streaming 67.910
] Stereo Systems Boom Box 9370
] Home Theater Systems 399,092
¥ Filter B Receivers 150,568
] Speaker Kits 244,199
] iPod Docking Station 311,103
] Televisions CRTTV 4,638
s Flat Panel TV 92,501
B Fortable TV 5049
] Video Production Video Edifing 199,749

6. Next, using the following steps, add a subquery SQL script for use as a filter on the first
report.

a. On the Data tab, in the Data Source group, click Switch.
Select the original Master File (wf_retail_lite).
b. Locate and double-click the Product,Category dimension field.

This creates a second report, which you can drag and resize as needed on the
Document canvas.
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c. Create a filter on Product,Category, where the product category is equal to Televisions.

1 Document

|:] Page 1 -

o, 1 . 2 . . &l . |5 .
1 Product Product Quantity Product
] Category Subcategory Sold Category
1] Accessories Charger 105,257 Televisions
B Headphones 228349
i Universal Remote Controls 178,061
] Camcorder Handheld 250,167
7 Frofessional 12,872
2 Standard 192,205
] Computers Smartphone 205,049
4 Tablet 146,728
] Media Player Blu Ray 679,495
5 DVD Players 18,835
B DVD Players - Portable 5,694
i Streaming 67,910
] Stereo Systems Boom Box 9370
b Home Theater Systems 399 092
e Receivers 150,568
i Speaker Kits 244 199
_ iPod Docking Station 311,103
] Televisions CRTTV 4,638
5 Flat Panel TV 92,501
B Fortable TV 5,049
] Video Production Video Editing 199 748

With the new component selected, click the Home tab and in the Format group, click File.

In the File name field, enter File2_subquery and select the SQL Script (*.sql) format from

the file types menu.

Click Save.

IBM



2. Creating HOLD Files ||

9. Rearrange the order of the HOLD files so that the File2_subquery is positioned above the
File1l_binary HOLD file using the following steps:

a. Rightclick Files in the Query pane and click Arrange Files, as shown in the following
image.

=| Query

d
; Arrange Files
- etail_lite)

3 FileZ_subquery (wf_retail_lite

The Arrange Files dialog box opens.

b. Using the Arrange Files dialog box that displays, select File2_subquery and click Move
Up to move the file above File1_binary, as shown in the following image.

a Arrange Files x

; Maove Up ¥

3 File2_subguery

0K

c. Click OK.
10. Edit the first report and create a filter using the subquery.
11. Click OK to exit the Create a filtering condition dialog box.

Your report is refreshed to reflect the filtering you have applied.

FOCUS Format Index Fields

FOCUS is the only format that supports an index field. The maximum number of fields to index
is four. If the file format is FOCUS, then Index appears on the Query pane.
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Creating a Subquery Filter Using a HOLD File

Procedure:

48

You can create a subquery using a HOLD file. A subquery is a nested query that is added to
the Where clause of an SQL statement. A subquery is valuable because it is highly reusable.
How to Create a Subquery Filter Using a HOLD File

This procedure describes how to create a subquery filter using a HOLD file created in the
previous procedure.

1. Build a report.
2. On the Data tab, in the Filter group, click Filter.
The Filter dialog box opens.

3. In the Create a filtering condition dialog box, from the Type drop-down menu, select
Subquery as the filter type for the left-most part of the expression.

4. From the Subquery drop-down menu, select In list as the comparison operator.

From the list of subqueries, select the subquery that was created (in this example, Filel)
for the right-most part of the expression.

6. Click OK.
The report is filtered by the subquery that you created.

Note: To view the SQL statements generated by the request, go to the Quick Access
Toolbar, open the Run drop-down menu, and select SQL Trace.
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Chapter

Creating Multi-Page Documents

In Document mode, content can be created on multiple pages. The available output
formats are: HTML, active report, PDF, active PDF, Excel (xIsx), and PowerPoint (pptx).
Additional Excel formats are available, as well.

Note: When working in Document mode using the active report format, you can create a
rich, multi-object document that integrates various reports and charts, closely resembling
a dashboard.

Microsoft Excel 2007 and Microsoft PowerPoint 2007 are enabled by default in the
Administration Console. To enable or disable formats, you must do so in the
Administration Console.

.4 The active report output format combines multiple reports and charts into one
document, resulting in a tabbed active dashboard.

4 Excel combines multiple reports as different sheets in a workbook.

.4 PowerPoint combines multiple reports and charts in a single slide.

In this chapter:

.4 Creating Multi-Page Documents

Creating a Multi-page Active Technologies Dashboard
Navigating the Page Menu

Using the Active Cache Option

L U o U

Enabling Active Cache Through InfoAssist+

Creating Multi-Page Documents

You can create multi-page documents, allowing you to display an array of information across
different pages.

Procedure: How to Create a Multi-Page Document

1. Create a new document.

Db2 Web Query InfoAssist+ Part 2



Creating a Multi-page Active Technologies Dashboard

Page 1 appears on the canvas title bar, as shown in the following image.

™ Ry

H QB R~

et | Format Data i Layout  view

Reports Objects Active Dashboard Prompts
B quey 29 Document DiFagei-
» [ i 3 B

¥ Fiter

Add content, such as a new or existing report, chart, text, and images to Page 1.

3. To add another page, do one of the following:
4 On the Insert tab, in the Pages group, click Page.

4 On the canvas title bar, click the page icon. From the Page menu that opens, select
New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the
canvas.

Each new page that you add is named Page n, where n is a unique number increasing by
an increment of 1.

4. Add content to Page 2.
Repeat steps 3 - 4 until your document is complete.

To navigate between pages, open the Page menu by clicking the Page icon at the top of
the canvas, as shown in the following image.

D Page 3@
Page 1

Page 2

L

Page 3

New Page

E
E‘T[ Page Options...

Creating a Multi-page Active Technologies Dashboard

You can create a multi-page active technologies dashboard using InfoAssist+.
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Procedure: How to Create a Multi-page Active Technologies Dashboard
1. Create a new active dashboard by setting the output format to active report.
Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, images, and active dashboard
prompts to Page 1.

3. To add another page, do one of the following:
.4 On the Insert tab, in the Pages group, click Page.

. On the canvas title bar, click the page icon. From the Page menu that opens, select
New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the
canvas.

Each new page that you add is named Page n, where n is a unique number increasing by
an increment of 1.

4. Add content to Page 2.
Repeat steps 3 - 4 until your dashboard is complete.

To navigate between pages, open the Page menu by clicking the Page icon at the top of
the canvas.

6. Run the active dashboard.
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The tabs appear at the top of the canvas, as shown in the following image.

El; Document1[0]

Layouts Page1 Page2 Page3 Paged

v v v
Accessories 2014 $11,114,636.00
2015 $24,666,032.00
2016 $36,845,694.00
Camcorder 2014  $13220,235.00
2015  $28838,292.00
2016 $42786,512.00
Computers 2014  $4,481,548.00
2015  §15898578.00
2016  $44,512,337.00
Wedia Player 2014 §23374,330.00
2015 $50,522,056.00
2016 §77,210,610.00

Navigating the Page Menu

SZ o

Gross Profit, MSRP BY Sale Year, Sale Quarter

Sale Year

2014

2015

160M
120M
a0M
40M

0
160M
120M

a0M
40M

2 3 4
Sale Quarter

W Gross Profit
MSRP

You can access the Page menu by clicking the Page icon in Design mode, as shown in the

following image.

D Page 3=

Page 1

—
-

Page 2

VALK

Page 3

1y
E MNew Page
E? Page Options...

The Page menu lists the pages in the order in which you created them. You can rearrange the
pages using drag-and-drop functionality. You can also select multiple pages and delete them.

In addition, the Page menu contains the New Page option to add a new page to the document.

The Duplicate option creates a duplicate page.
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The Page menu also contains Page Options which you can click to launch a dialog box of the
following options:

4 Rename Page
4 Duplicate Page
.4 Move Page Up

-1 Move Page Down
d Delete

The Page Options dialog box is shown in the following image.

Ef Page Options xX
B0 a v X
D Page 1
D Page : iﬂl Cuplicats
[ Page : [% Rename

s Move Up

w Move Down
44 Delete

0K

When you select a page, the Duplicate, Rename, Move Up, Move Down, and Delete options
become active in the menu bar at the top of the dialog box. Also, when you right-click a page, a
context menu of these same options opens.

The position of the page that you have selected determines which directional options are
available. For example, Move Up would not be an option for Page 1. Move Down would not be
an option for the last page.

To close the dialog box, click OK.

Db2 Web Query InfoAssist+ Part 2 53



Using the Active Cache Option

Using the Active Cache Option

Because all post-retrieval processing is performed in the memory of the web browser, an active
report has a processing limit of approximately 5,000 records or 100 pages of output. The
active cache option enables you to send only the first page of active report output to the
browser and retrieve subsequent pages from a temporary cache on the Reporting Server.

Tip: It is recommended that you set the number of rows retrieved five times greater than the
number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows
retrieved is 100.

Enabling Active Cache Through InfoAssist+

Active cache is enabled when you select active report as the output type and the Pages on
Demand button (Format tab, Navigation group) is enabled.

The Advanced tab on the active report options dialog box contains the Rows Retrieved drop-
down list. Use this setting to establish the increments in which the cached data stored in a
binary file is returned to the output window. The default is 100.

Note: In a multi-page document, active cache must be enabled per component. It is not
globally set. Therefore, when creating a document in AHTML format, you must select each
component separately to enable active cache. When you do so, the Pages on Demand button
is activated.
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Chapter . .
Components With InfoAssist+

This topic describes how to create a report, chart, or dashboard that is enabled for Active
Technologies using InfoAssist+.

These reports, charts, and dashboards use the full capabilities of Active Technologies.
They are also referred to as active reports, charts, and dashboards.

In this chapter:

4 Using Active Technologies

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache
processing. It includes additional information about the features of the product that will help
you use it.

This topic also describes the features of an Active Technologies report, which is a report that
is enabled to use the full capabilities of Active Technologies. An Active Technologies report is
also called an active report.

Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report,
you can:

. Interact with the data, using analysis options similar to those found in an Excel® workbook,
without any connection to a server. Analysis options include filtering, sorting, charting, and
much more.

4 Work offline without any additional plug-ins or programs. An active report is a self-contained
report, meaning that it contains all the data and JavaScript® within the HTML output file.
Packaging the data and the interactive functions in the HTML file also makes the output
highly compressible for email and transparent to security systems.

.4 Save the report on a local machine with active report functionality. Since no connection to a
server is required to view the data or use the analysis options, you can save and use the
report anywhere.

Note: Performance may vary across browsers due to browser-specific memory limitations.
For very large reports, Internet Explorer® may produce an error. For more information, refer
to the Microsoft® website.
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An active report for Adobe Flash Player includes most of the capabilities available in the HTML
version of active reports in a visually enhanced, user-friendly report format. An active report
delivered as a self-contained Adobe Flash SWF file that is Adobe Flash Player compatible
allows for faster analysis of large data sets and interaction with the active report.

When working with an active report, you can:
. Filter or highlight data.
Sort data within any column in ascending or descending order.

Apply calculations to columns and choose the location at which to display results.

L LU L

Control the display of data by hiding columns, freezing columns, limiting the number of rows
per page, and using graphic visualization to compare column values.

Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.
Apply a global filter to multiple reports within the same HTML page.
Export report data and chart data.

Restore original report settings.

L U o oo U

Run active reports on your mobile device with the Opera™ browser (Version 8.60 U2 or
higher) installed. See the Opera website for a list of supported devices.
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The following image shows an HTML active report. The pop-up menu is open for the Sale

Unit(s) column, with the Calculate Avg operator selected.

K

Sq;‘.;:re Store

Business Business

Region ¥ Sub Region v

EMEA Africa $
Asia $264
Europe $396 2

North America Canada $51.1
East $39.0
Mexico $12.9
Midwest $60.9
Northeast $1.5
South $77.4
Southeast $4.4
West $362,3

Oceania Australia-New Zealand  $1.2

South America SA-Port $259

SA-Span $1.2

14 of 14 records, Page 1 of 1
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Clear All
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The following image shows the options that are available at the cell level for a report in active
report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking
functionality. The applicable documentation for your graphical tool contains more information
on that functionality.

lIProduct Quantity
|ICategory ¥ CostofGoods ¥ Sold ¥

AL CESSOMEs $89,753,698.00 511,667

$104,666,557.00 455244

351,777
771,834

1,114,332

105,188

199,748

Note:

.4 Depending on how your active report has been set up, some options may not be available
in your report.

.4 When using active reports, it is recommended that you set the system font display to
normal to ensure that the menu icons display correctly.

.4 Freeze options are only available when a report does not fit in the current window.
Therefore if your report fits in the current window, Freeze options appear grayed out in the
menu. If you resize the report, or a column or row extends beyond the proportion of the
window, then Freeze options become activated and are available for use.

Security Features

58

You can password protect an active report. This feature restricts users from viewing the report
by requiring them to enter a password before opening the report. The data is encrypted using
the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the
key for decrypting and encrypting the data. Therefore, the password is not stored in the report,
and you do not need a connection to go back to the server for password verification.
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The HTML page that you receive contains both the JavaScript and the data for the report so
that you can interact with the data in a disconnected mode. Internet Explorer detects the
JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions
explicitly the detection of active content, which is the JavaScript. The same warning appears
when pop-ups are blocked in the browser.

Handling a Large Amount of Data

Because all post-retrieval processing is performed in the memory of the web browser, an active
report has a processing limit of approximately 5,000 records or 100 pages of output. The
active cache option enables you to send only the first page of active report output to the
browser and retrieve subsequent pages from a temporary cache on the Web Query Reporting
Server. The server also becomes the resource for performing all calculations, sorting, and
filtering when active cache is enabled. Since active cache uses on-demand paging
functionality, WebFOCUS Viewer is not supported.

The active report with active cache option in the clustered server environment, using Cluster
Manager (CLM), will maintain the connection with the Web Query Reporting Server on which the
temporary cache is created. This enables the retrieval of subsequent pages from the browser,
while the report is in the same browser session.

The active cache feature uses a POST instead of a GET in an HTTP request.

If your applications run active cache reports that use Web Query Web Services, see the Web
Query RESTful Web Services Developer's Guide for more information.

Distribution and Viewing Considerations

Active Technologies stores an active report as an HTML file. The HTML file created by Active
Technologies contains both the report data and the JavaScript code that enables you to
interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and
interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send
an active report to another person by email, as an HTML attachment. However, when you
distribute an active report, you must keep in mind how it will be viewed.

For example, when you send an active report as an HTML attachment to email, many client
email programs on a mobile device can block the JavaScript in the attachment. A third-party
tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the
attachment.
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If you try to view an active report in a web browser, and JavaScript is blocked or disabled on
your web browser, you will receive a message reminding you that JavaScript must be enabled
on the browser. If you are using a mobile device, the message directs you to use the Mobile
Faves App. If the Mobile Faves App is not installed, you can download it from the App Store®
for iOS devices or from the Google Play™ store for Android™ devices. In the message, App
Store and Google Play store are hyperlinks to the Mobile Faves App.

The message is displayed on the Desktop or on a supported mobile device when JavaScript is
disabled in a web browser used to open an online or offline active report. It is also displayed
on the Preview pane or window of an application used to preview the content of an offline
active report.

The following image shows JavaScript disabled in Google Chrome™.

Content settings *
-
Cookies
[ : I Allow local data to be set (recommended)
8 Keep local data only until you quit your browser
Block sites from setting any data
Block third-party cookies and site data
Manage exceptions... All cookies and site data...
Images
®) Show all images (recommended)
Do not show any images
Manage exceptions...
JavaScript
Allow all sites to run JavaScript (recommended)
®) Do not allow any site to run JavaScript
Manage exceptions...
Key generation
Allow all sites to use key generation in forms. -

Done
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Usage Notes for Active Technologies

The following apply to browser support.

_I

_I

Active PDF (APDF) is an Active Technologies output format. It is not supported in Microsoft
Edge®, since APDF requires the Adobe Reader plug-in that supports Flash Player.

ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Any Active
Technologies feature that requires the use of ActiveX controls is therefore not available in
Microsoft Edge. These features include the following, which are accessible in other
browsers at run time, using the column drop-down menu on an active report:

. Send as E-mail (supported only in Internet Explorer)
.4 Save Changes (supported only in Internet Explorer)
.4 Export to XML (Excel) when active cache is disabled

If you are using a Firefox® browser and you export an AHTML report to Excel, the file
extension that displays is incorrect (for example, .xls.xls). You can override this default
value using the settings of the browser. Specifically, if you click the Always ask me where to
save files radio button, which is located under Options, you will be prompted, upon
download, to either open or save the file. You can then provide a name and extension for
the file.

The following apply to Active Technologies reports.

-

_I

If multiple report components with different security passwords are included in an AHTML
document, the password for the last report component is used.

Active reports employ left and right cell padding, by default. This enables you to view the
active report consistently, without the concatenation of any values or spacing issues
related to the cell padding. In cases where these settings are not defined in the
StyleSheet, the default settings for the left and right cell padding are used.

By default, Active Technologies displays the name specified in the Master File to identify a
column in an ACROSS group on a tabular active report. With the following SET command,
you can display the title specified in the Master File, instead of the name, to identify the
column:

SET ACRSVRBTI TL = ON

Active Technologies derives the title from the TITLE attribute in the Master File (for
example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute
(for example, FIELD = PCD).
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-l The Sort Ascending, Sort Descending, and Restore Original options are accessible on a
column drop-down menu on an active report. When active cache is enabled on the active
report, the Restore Original option does not return the report output to its original state
after sorting the data. Instead, you receive the following message: Warning: Original sort
could not be determined.

4 When using active content in Cache Mode, filtering may not work properly if the content
contains a text field (for example, TX50). As a workaround, consider using an alphanumeric
field (for example, A50).

The following apply to Active Technologies charts.

.4 The new chart attribute syntax has been applied to the following chart types: Dual Bar and
Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional
relevant field containers for these chart types, which can be used to specify fields in a
specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field
containers that are part of the new chart attribute syntax.

In InfoAssist+, specific field containers display for each chart type.

The following applies to Active Technologies tools.

4 The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when
active cache is enabled.

The following apply when using the Export to Excel functionality.

4 When using the Export to Excel option while creating and generating an active report with
active cache enabled, the request will be generated in XLSX format rather than EXL2K. This
applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

The export behavior is controlled by the Reporting Server, and an ActiveX plugin is not
required for Internet Explorer. When the export is performed, an Office Open XML document
is produced, which you can download and save in the required format (default is .xlsx).

4 When using the Export to XML (Excel) option with active cache disabled, the export behavior
is controlled by the active JavaScript layer.

An ActiveX plugin is required for Internet Explorer. This is used to export the output directly
into Microsoft Excel, enabling you to save the document in the required format (.xIsx or .xIs
depending on the Microsoft Excel version installed).

In Firefox and Chrome, when the export is performed, an MS Office XML document is
produced, which you can download and save in the required format (the default is .xls).
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In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available
with active cache disabled, but when the export is performed, the output is displayed as
text inside the browser window.

The following apply when using mobile devices.

.4 The Chrome browser "Force enable zoom" Accessibility setting on Android mobile devices
overrides a website request to prevent zooming. If this setting is enabled when executing
an AHTML report on an Android mobile device using Chrome, it interferes with active report
functionality, such as FREEZE and manual resizing. The Accessibility setting needs to be
disabled for active reports to be fully functional.
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Chapter

Creating an Active Technologies
Component

This topic describes how to create a report, chart, or dashboard that is enabled for Active
Technologies using InfoAssist+.

These reports, charts, and dashboards use the full capabilities of Active Technologies.
They are also referred to as active reports, charts, and dashboards.

In this chapter:
.4 Creating an Active Technologies Report
.4 Creating an Active Technologies Chart

.4 Creating an Active Technologies Dashboard

Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

Procedure: How to Create an Active Technologies Report

With InfoAssist+ in Report mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click active report or active PDF.

2. Populate the report with your data in one of the following ways:
.4 Drag the dimension fields and measure fields onto the canvas.

- Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

Active Technologies Report Menu Options
Menu options for an active report are described in the following table.

Note: The following options described in the table require the use of ActiveX controls. Since
Microsoft Edge does not support ActiveX technology, these options are not available in that
browser:

4 Send as E-mail
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-1 Save Changes

.4 Export to XML (Excel) when active cache is disabled

Option

Definition

Sort Ascending

Sorts the column in ascending order.

Sort Descending

Sorts the column in descending order.

Filter

Filters the data. Options are:
4 Equals

4 Not equal

-l Greater than

4 Greater than or equal to
d Less than

4 Less than or equal to

1 Between

-l Not Between

d Contains

.4 Contains (match case)
4 Omits

1

Omits (match case)
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Option

Definition

Calculate

Calculation types that you can apply to the column:
d Clear

- Clear All

4 Count

. Distinct, which counts the number of distinct values within a
field

For numeric fields, you can also apply:
Sum
Avg
Min
Max

Count

L U U o o U

Distinct, which counts the number of distinct values within a
field

- % of Total

Chart

Creates an active chart from the report. Options are Pie, Line,
Column, and Scatter.

Rollup

Lists the fields available to create a table.

Pivot (Cross Tab)

Lists the fields available to create a Pivot table.

Visualize Adds visualization bars to, or removes them from, the selected
column. The Visualize option is available for numeric data
columns.

Hide Column Suppresses the display of the selected column in the report.
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Option

Definition

Show Columns

Lists the names of the columns that are hidden in the report,
allowing you to individually restore a column.

Select the name of a specific column in the hidden columns list to
restore that column to the report.

Freeze Column

Freezes the report at a particular point so that columns to the left
of the freeze point remain in view while the user scrolls through
the other report columns.

Note: If the report can be fully viewed in the browser window,
freeze is not applied. The Freeze column option is not available for
expandable report (Accordion) views.

Unfreeze All

Unfreezes the columns.

Grid Tool

Opens the Grid Tool, which you can use to change the column
order, select multiple columns to sort ascending or descending,
hide and show columns, add a calculation result to a column, and
add subtotals to the active report.

Chart/Rollup Tool

Opens the Chart/Rollup Tool, which you can use to select multiple
group fields to generate the chart or rollup table. The Chart/Rollup
Tool contains a list of columns available in the active report to add
to Group By and Measure fields. Drag the columns into the field
that you want.

Pivot Tool

Opens the Pivot Tool, which you can use to select multiple group
fields to generate the chart or pivot table. The Pivot Tool contains
a list of columns available in the active report to add to Group By,
Across, and Measure fields. Drag the columns into the field that
you want.

Show Records

Opens the Show Records menu option to list the number of
records available for display per page in the report. Select a
number (for example, 10) to display, per page. Default displays the
number of records (lines) per page that is specified in the report
procedure.
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Option

Definition

Comments

Options to display comments under cells or hide indicators for
comments in the active report output.

Send as E-mail

Enables you to save the current state of the active report and send
the report as email.

Note: To use this feature, you must have ActiveX enabled in your
browser security settings.

This feature is only supported in Internet Explorer.

Save Changes

Saves the current state of the active report.

When you save an active report using the browser Save as option,

the report is saved in its original default state. In the browser Save
as dialog box, we recommend that you select the Webpage, HTML

Only save option to ensure that the page is saved properly.

Note: To use this feature, you must have ActiveX enabled in your
browser security settings.

This feature is only supported in Internet Explorer.

Export When active cache is enabled, exports all records or filtered only
records to HTML, CSV, Excel, or PDF.
Note: active cache is enabled on an active report when you click
Pages On Demand on the Format tab, in the Navigation group.
When active cache is disabled, exports all records or filtered only
records to HTML, CSV, or XML (Excel). To use this feature, you
must enable ActiveX in your browser security settings.

Print Prints all records or filtered only records.

Window Displays reports in a cascade or separate tabs.

Restore Original

Restores the active report to the default state specified in the
report procedure.

Active Technologies Cell Menu Options

When you are working in active report format, the following data cell options display.
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Option Definition

Drill down Enables you to drill down one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Drill up Enables you to drill up one level in the hierarchy of your
data source. This option displays for reports that have Auto
Drill enabled.

Restore Original Restores the active report to the default state specified in

the report procedure.

Auto Links Displays a list of target reports that are linked to the Auto
Link enabled report. This option displays for reports that
have Auto Linking enabled.

Comments Enables you to add comments about data in your report.
The result is an annotation that displays when you hover
over it at run time.

Highlight Value Enables you to highlight a particular value in your report.

Highlight Row Applies highlighting to the selected row in your report.

Unhighlight All Removes any applied highlighting from values or rows in
your report.

Filter Cell Enables you to filter the output, showing only a selected
row of data.

Remove Cell Filter Removes any applied cell filters.

Configuring Active Technologies Report Options

You can configure active report options, including menu options, based on user role, through
the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the active
report options button. The button is available when active report or active PDF is selected as
the output type.
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The active report options dialog box contains the following tabs:
4 General

d Menu Options

4 Colors

4 Advanced

General Tab
Use the General tab to set common properties specific to active reports.
The General tab contains the following options:

Display. This area contains options to set the window to cascade or tabs, and options to
freeze columns.

.d Window. Select the window setting. The options are Cascade and Tabs.

.d Freeze Columns. Select the columns you would like to freeze. You can also select None.

Page Options. This area contains options to set the number of records per page, enable the
display of page information, edit the alignhment, and set the location of the page information.

-1 Records Per Page. Select or type the number of records that you would like to display per
page. The default value is 57.

.d Display Page Information. Select this option to display page navigation information. Clear
this option to disable the display of page navigation information.

.4 Alignment. Click the appropriate button to set the alignment of the page navigation
information. Options are Left, Center, and Right.

.4 Location. Select the location for the page navigation information. The options are Top Row
and Bottom Row.

Chart Options. This area contains options that pertain to charts when the output format is
active PDF.

Note: Chart Options do not display when the output format is active report.

d Legend (check box). Select this option to collapse the legend if necessary. Clear this
option if you do not want the legend to collapse.
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- Legend (menu). Select the location for the legend. The choices are:

-1 Bottom Left

- Bottom Center

- Bottom Right

Menu Options Tab

Use the Menu Options tab to select a user type and which options to display in the menu.

The Menu Options tab contains the following options:

-l User Type. The options are Power, Analyst, Basic, and Custom.

d Power. This is the default user type. It enables all functionality.

- Analyst. This user type has the following functionality: Show Records, Freeze, Hide/

Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original,
Save Changes, and Accordion.

Basic. This user type has the following functionality: Show Records, Freeze, Hide/
Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.

Custom. If you select a combination of options that does not match one of the existing
user types (Power, Analyst, Basic), the User level name that appears in the User Type
field is Custom. This is not a default user type or a selectable user type. It indicates
that options for this user do not match any of the existing user types.

The options available according to user type include the following:

-

L LU L

L L L U

Show Records. Shows all records or specific numbers of records.
Freeze. Freezes and unfreezes columns.
Hide/Unhide. Hides and shows columns.

Export. Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to
HTML, CSV, or XML (Excel) if active cache is disabled.

Sorting. Sorts data in ascending or descending order.
Pivot. Lists the fields available to create a Pivot table.
Window Type. Shows windows as cascade or tabs.

Send as Email. Enables you to save the current changes and send a report as email.
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Print. Prints all records or filtered-only records.
Advanced Tools. Accesses the Chart/Rollup, Pivot, and Grid Tools.

Filter. Opens the Filter Selection dialog box.

L o U ud

Calculations. Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct,
% of Total.

Chart. Converts a report to a pie, line, bar, or scatter chart.
Visualize. Adds data visualization bars to a report.
Rollup. Performs rollup on data.

Comments. Adds comments.

L U U o U

Restore Original. Restores the active report to the default state specified in the report
procedure.

L

Save Changes. Saves the current changes.
.4 Accordion. Produces accordion reports.

.4 Grid Tool. Opens the Grid Tool dialog box.

Colors Tab
Use the Colors tab to select colors for various objects on the report.
The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page
text.

4 Font. Opens the Color dialog box, where you can select the font color.

4 Background. Opens the Color dialog box, where you can select the background color for the
page text.

Row Selection. This area contains options to set the colors that appear when you point to or
select a row on the report.

.d Hover. Opens the Color dialog box, where you can select the color that the row becomes
when you hold the mouse over the row.

d Selected. Opens the Color dialog box, where you can select the highlight color that the row
becomes when you use the highlight option.
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Visual. This area contains options to set the colors for the data visualization bars.

- Positive. Opens the Color dialog box, where you can select the color for a data visualization
bar that represents a positive number.

1 Negative. Opens the Color dialog box, where you can select the color for a data
visualization bar that represents a negative number.

Calculations. This area contains options to set the colors for values in a calculation.
- Font. Opens the Color dialog box, where you can select the font color for the calculation.

- Background. Opens the Color dialog box, where you can select the background color for the
calculation.

Menu. This area contains options to change the color of the menu.
- Normal

- Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus.

- Background. Opens the Color dialog box, where you can select the background color for
the column menus.

- Border. Opens the Color dialog box, where you can select the color for the border of the
column menus.

-1 Hover

- Font. Opens the Color dialog box, where you can select the color for the text of the
options on the column menus when you point to them.

1 Background. Opens the Color dialog box, where you can select the background color
that appears behind options on the column menus when you point to them.

Advanced Tab

Use the Advanced tab to control the number of rows retrieved from active cache and to add
security settings.

Note: active cache is enabled when you select active report as the output type, and click Pages
On Demand on the Format tab, in the Navigation group.

The Advanced tab contains the following options:
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active cache. Enables a report to cache the data in a binary file and return the data to the
output window in pre-set increments.

4 Rows Retrieved. Select the number of rows retrieved in the output. The default value is
100.

Security. This area allows you to set a password to access the report and enable expiration by
date or by days. This option is only available for the active report output.

Note: When setting security options for active reports, be aware that security options can be
set for each individual component on the canvas, but only one password can be set for the
entire document.

Creating an Active Technologies Chart

An active chart is a chart that is designed for offline analysis. For more information, see Active
Technologies Report Overview on page 55.

Note: Active Technologies supports the use of HTML5 extensions, which are user-supplied,
custom chart types that access resources external to Web Query.
Procedure: How to Create an Active Technologies Chart

With InfoAssist+ in Chart mode, you can perform this procedure in Query Design view or Live
Preview.

1. On the status bar, in the Output Types menu, click active report or active PDF.

2. On the Format tab, in the Chart Types group, click the button of the chart that you want to
create. Bar chart is the default.

The chart appears on the canvas.

3. Populate the chart with your data in one of the following ways:
- Drag the dimension fields and measure fields onto the chart.

.4 Drag the dimension fields and measure fields into the appropriate field containers in
the Query pane.

Db2 Web Query InfoAssist+ Part 2 75



Creating an Active Technologies Chart

The following image shows an HTML5 pie chart that displays the sum of the values in the
Quantity Sold field by Product Category.

E%—\

3%—\

L—13% Product Category
M Accessories
Camcorder
. Computers.
Media Player
B Stereo Systems
Televisions
Video Production

32%

L22%

Quantity Sold

Active Technologies Options for Charts
Options for an active chart are described in the following table.

Note: For charts that employ the new attribute syntax, only the following four icons display:
More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the
Remove Filter icon displays.
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Option

Definition

More Options

New. Creates a new instance of the chart. This option is available only when the
chart is created from a column menu on a tabular report.

-
Group By (X). Changes groups by the horizontal sort field.
Add (Y). Adds a vertical sort field.
X-Axis. Specifies a measure or dimension sort field. Applies to scatter charts.
Y-Axis. Specifies a measure. Applies to scatter charts.
Arrange By. Specifies the marker color. The marker color depends on the field
assigned to the color attribute. If no field is assigned to this category, then all of the
markers will be the same color. Applies to scatter charts.
Export to. Exports to Excel, Word, or PowerPoint.
Stacked. Stacks the risers on top of each other, with the length of each riser
representing the data value. Applies to column charts.
Top. Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top.
Applies to pie charts.
Trend. Draws a trendline and equation label for an individual series. Applies to
scatter charts.
Chart/Rollup Tool. Opens the Chart/Rollup Tool, which you can use to select
multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool
contains a list of columns available in the active report and Group By and Measure
sort fields. Drag the columns into the desired sort field.
Note: When working with the Chart/Rollup Tool for active charts (specifically those
with the new chart attribute syntax), the Series tab is not supported. It is available
with charts that are created with tabular reports or stand-alone charts that do not use
the new chart attribute syntax.
Restore Original. Restores the active report to the default state specified in the
report procedure.

Column Displays data as a column chart.
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Pie Displays data as a pie chart.

e

Line Displays data as a line chart.
Scatter Displays data as a scatter chart.
Rollup Displays the chart as a rollup table.

Advanced Chart

"

i

EOITT

Opens the Chart/Rollup Tool.

Original Chart

b

Restores the active chart to the chart type specified in the report procedure.

Lock/Unlock

o

Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the
filters that you have applied in your report using the Freeze Chart or Freeze Rollup
icon. The icon indicates whether the report is linked to the filter (Freeze Chart or
Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup).

This option is available only when the chart is created from a column menu on a
tabular report.

Aggregation Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and
xou Distinct. The default value is Sum.
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Remove Filter Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area
of the chart and then clicking the Filter Chart or Exclude from Chart option from the
j chart tooltip.

Usage Notes for Active Technologies Charts

If you are working with an AHTML chart that does not have the new chart properties
(specifically, non-bucket AHTML charts), you will encounter problems if you change the chart
type to one of the following chart types using the Advanced Chart tool at run time:

. Tag Cloud
Funnel
Pyramid

Waterfall

1

1

1

.d Histogram
. Radar Line
.d Radar Area
4 3D Area

By default, these chart types are hidden in the Advanced Chart tool when the original chart is
an AHTML bucket chart. These chart types are available under the following circumstances:

4 When the original chart is a non-bucket chart

d When the chart is created from a tabular report

Creating an Active Technologies Dashboard

You can create an active dashboard by inserting multiple content types, such as reports,
charts, images, and text, into a document. An active dashboard will run any report or chart
using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports
and charts on the dashboard. You can cascade (chain) prompts to populate them based on the
selections from the previous prompts.

Db2 Web Query InfoAssist+ Part 2 79



Creating an Active Technologies Dashboard

The output format of the active dashboard must be active report or active PDF in order to add
active dashboard prompts.

Active Technologies Dashboard Prompts

The active dashboard prompts group contains buttons that insert active dashboard prompts
into your dashboard. This group is only visible when the output format of the dashboard is set
to active report or active PDF. You can access the active dashboard prompts on the Insert tab,
in the active dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an
active dashboard:

- Drop Down. Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- List. Inserts a list prompt placeholder in the upper-left corner of the canvas.

-1 Checkbox. Inserts a check box prompt placeholder in the upper-left corner of the canvas.
M|

Radio Button. Inserts a radio button prompt placeholder in the upper-left corner of the
canvas.

d Text. Inserts a text area prompt placeholder in the upper-left corner of the canvas.

Note: The display of values populated in active dashboard prompts is dependent on the data
setting. For example, if sample data is turned on, then active dashboard prompts will show
sample data, such as:

WF_RETAI L1

WF_RETAI L2
WF_RETAI L3

Target Reports
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When you bind a field to an active dashboard prompt, the default target report is the report
from which you dragged the field. You can add or remove target reports from an active
dashboard prompt through the active dashboard properties dialog box.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name
or AS name).

d The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title
and the title is changed, the report is automatically removed as a target.
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Procedure: How to Add an Active Technologies Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and
binding a single prompt to one of the fields of the report.

With InfoAssist+ in Document mode:

1.

On the status bar, in the Output Types menu, accept the default output type (active
report), or click active PDF.

On the Insert tab, in the Reports group, click Report.
A placeholder appears on the canvas.

Drag fields onto the canvas, or into the Query pane, to create the report and start building
the dashboard.

On the Insert tab, in the active dashboard prompts group, select a dashboard prompt to
insert into the document.

An active dashboard prompt appears in the upper-left corner of the canvas. If the report is
located in the upper-left corner of the canvas, you will have to drag the prompt off the
report.

Select the report and bind one of its data source fields to the prompt in one of the
following ways:

. Query pane: Select the report. From the Query pane, drag the field that you want to
bind onto the prompt.

4 Report on the canvas: Click the report on the canvas. You can now edit it. Highlight
the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

Note: Once an active dashboard prompt is added to the canvas, the document is locked in
an active output format. You cannot change the active report or active PDF format if there
are prompts present on the canvas. To switch to a non-active output format, you must
remove all prompts.

Using Multiple Reports as Targets and Sources

You can add multiple reports and charts to an active dashboard. Each report can have multiple
prompts associated with it.
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Procedure: How to Build a Dashboard With Multiple Reports as Targets and Sources
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The following procedure describes how to set up active dashboard prompts for two reports on
a dashboard. In the example that is used, the first report contains information about the
categories of electronics products sold in various regions. The Product,Category field will be
bound to a group of radio buttons. Each radio button will represent a particular product
category of electronics. When you select a radio button for a product category, for example,
Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of
electronics consumers. The Gender field will be bound to a drop-down list. The list will display
the values, F (female) and M (male). When you select a gender from the drop-down list, the
report will be filtered by your selection.

1.
2.

Open InfoAssist+ in Document mode using the wf_retail_lite Master File.

Create an active dashboard by adding two reports with the following components,
respectively:

Report 1:

.4 Product,Category

d Store,Business,Region
-l Discount

- Gross Profit

Report 2:

- Gender

-l Customer,Continent

. Product,Category

On the Insert tab, in the active dashboard prompts group, add the following active
dashboard prompts to the dashboard, positioning them relative to each respective report.

.4 Radio Button: This prompt will be used for Report1.
. Drop Down: This prompt will be used for Report2.

For more information on working with active dashboard prompts, see How to Add an Active
Technologies Dashboard Prompt to a Dashboard on page 81.

Right-click the radio button active dashboard prompt for which you want to bind a field to
and click Properties.

The active dashboard properties dialog box opens.
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The Prompts list displays the two prompts (for example, radiobutton_1 and combobox_2)
that were added to the dashboard in Step 3.

5. From the Report drop-down menu, select the report that contains the field to which you
want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for
the region report (Report 1), as shown in the following image.

{f_f Active Dashboard Properties
[#] Prompt Source & Targets T Cascades

Prompts Source Targets

(@) radiobutton_1 Report Candidate Reports Targets
™ combobox_2

Name Name

Ei Reportl E] Report2 E] Reportl
" Report2 L\\,

FIUUULL LdiEgury -

Condition
Equal to -

Sort
Ascending -

«| Include All

o OK & Cancel 2 pply

The next step describes how to bind the Product,Category field from the region report to
the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active
dashboard prompt.
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In this example, the Product,Category field has been selected for the radio button list
(radiobutton_1), as shown in the following image.

{’f Active Dashboard Properties
@ Prompt Source & Targets % Cascades

Prompts Source Targets

(@) radiobutton_1 Report Candidate Reports Targets

™ combobox_2

Reportl - MName Name

Field % Report2 % Reportl

“Gross Profit
Product,Category
Discount

Store,Business,Region
50

Ascending -

«| Include All

W OK S Cancel 2 Apply

Note: You can optionally specify an ascending or descending sort order for the current
scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
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In the following image, the radio button list is bound to the Product,Category field. It

displays all product categories by which you can filter the report.

(% [AI]

) Accessaries
) Camcorder
) Computers
Media
Player

Stereo
Systems

~

Product
Category v

Arcessories

Camcorder

Computers

Media Player

Stereo Systems

Televisions

Video Production

Store
Business
Region ¥

EMEA
Maorth America
South America
EMEA
Morth America
South America
EMEA
Morth America
South America
EMEA
Maorth America
South America
EMEA
Marth America
South America
EMEA
Morth America
South America
EMEA
Morth America

South America

21 of 21 records, Page 1 of 1

Digzcount ¥ Gross Profit ¥

52,437 956.41
53,416,809.19
2153,257 .58
52,540,963 45
54,075,160.76
$185,793 84
51,700,675.30
52,999,143.76
5100,862.80
54,678,461.09
56,522,133.78
5304,865.00
55,428,981.57
57,744,502.52
$341,022.82
51,518,009.74
52,013,911.63
5102,362.82
51,066,117.73
51,552,040.11
£73,964 80

$15,898,776.98
§22.879,859.37
$1,027,460.88
519,925,603.81
525,304,171.48
$1,309,721.34
$12,147,362.23
§20,556,914.70
3753,505.60
§22.897,933.25
$31,364,927.54
$1,499,92575
$34,639,882.85
549,228 757.29
$2,214,130.64
$6,990,404 95
$9.355,461.12
5462,120.21
$7,195,930.82
F10,272,127.15
5460,856.91

The following steps describe how to bind the Gender field in the gender report (Report2) to
the drop-down list prompt.

Right-click the Drop Down active dashboard prompt for which you want to bind a field and
click Properties.

The active dashboard properties dialog box opens again.

Notice that combobox_2, the prompt selected on the dashboard, is selected in the

Prompts list.
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9. From the Report drop-down menu, select the report (Report2) that contains the field to
which you want to bind an active dashboard prompt.

The next step describes how to bind the Gender field from the gender report to the drop-
down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the
active dashboard prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets
list and Reportl (region report) appears in the Candidate Reports list.

Note: To move a report from the Candidate Reports list box to the Targets list box, select
it and click the Add to List arrow. To remove a report from the Targets list box, select it
and click the Remove from List arrow. You can select multiple reports by holding down the
Ctrl key and clicking each one.

11. Click OK.

The prompt is now bound to the Gender field on the dashboard. You can now filter the
gender report by female or male, as shown in the following image.

Customer Product
Gender ¥ Continent ¥ Category T
F Africa ACcessories
F Camcorder
M Computers
Media Player

Stereo Systems
Televisions
Video Production
Asia Accessories
Camcorder
Computers
Media Player
Stereo Systems
Televisions

Video Production
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The final active dashboard displays, as shown in the following image.

® [an Store [AI] Customer Product

- A Product Business F Gender ¥ Continent ¥ Category ¥
() Accessories v i ¥ Di: i it ¥

: Category Region Discount Gross Profit M F Africa rnate

_) Camcorder Accessories EMEA $2,437,956.41  §15,898,776.98 & o

% amcorder
() Computers Morth America §3,416,809.19  §22,879,859.37

= x Computers
() Media Player QOceania $6,822.34 $48,343.30 SacdiaP

edia Player

O Stereo South America  $153,257.58 $1,027,460.88

~ Systems v Stereo Systems
- GCamcorder EMEA 52,840,963 46 519,928,603 81

) Televisions Televisions

Morth America §4,075,160.76  528,304,171.49
Video Production
Qceania $6,490.21 $56,348.60

Asia Accessories
South America  $185,793.84 $1,309,721.34
Camcorder
Computers EMEA 51,70067530 512,147,36223
Computers
Morth America §2 99914876 §20,556,914.70
Media Player
Oceania $8,223.24 $51,035.59
Stereo Systems
South America  $100,862.80 $753,505.60
Televisions
Media Player EMEA 54,678,461.09 522,897,93325
Video Production
Morth America §8522 13378  §31,364,527 54
M Africa Accessories
Oceania $13,682 45 $69,788 .82
Camcorder
South America  $304,865.09 $1,499,928 75
Computers
Stereo Systems EMEA $5,428,981.57 534,639,862.85
Media Player

Morth America §7,744,502.52  §49,223,757.29

Stereo Systems
Oceania $16,366 66 $98,299.74

Televisions
South America  $341,022.82 $2,214,130.64

Video Production

Televisions EMEA §1,518,099.74 56,990,404 98
Asia Accessories
Morth America $2,013,911.63 $9,358,461.12
Camcorder
Oceania $1,319.19 $19,037.50
Computers
South America $102,362.82 $462,120.21
Media Player
Video Preduction EMEA §1,066,117.73 $7,195,930.82

Stereo Systems
Morth America §1,552,040.11  §10,272,127.15

Oceania $3.768.12 $18,70474

Televisions

Video Production
South America $73.964 30 460,856 91
28 of 28 records, Page 1 of 1
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Procedure: How to Change the Field
You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind
an active prompt to a field.

2. Rightclick the active dashboard prompt that you want to configure, and click Properties.
The active dashboard properties dialog box opens.
3. From the Field menu, select a different field.

A warning message alerts you that changing the source field for the prompt will remove the
existing prompt and any dependent (child) prompts from the cascades.

Click OK to close the warning.

5. Click OK to close the active dashboard properties dialog box.

The active dashboard prompt is updated with the new source field.
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Procedure: How to Change the Filter Condition

1.

Create an active dashboard in Document mode, or open an existing dashboard, and bind
an active dashboard prompt to a field, as described in How to Add an Active Technologies
Dashboard Prompt to a Dashboard on page 81.

Right-click the active dashboard prompt that you want to work with, and from the shortcut
menu, select Properties.

The active dashboard properties dialog box opens.

From the Condition drop-down menu, select the filter condition for the active dashboard
prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater
than, and Greater than or equal to.

Click OK.

The filter condition is applied to the active dashboard prompt.

Procedure: How to Add Multiple Prompts to a Dashboard

1.

Create an active dashboard in Document mode, or open an existing dashboard containing
at least one report, and add at least two active dashboard prompts, as described in How
to Add an Active Technologies Dashboard Prompt to a Dashboard on page 81.

Bind the fields to prompts that you have added, as described in How to Add an Active
Technologies Dashboard Prompt to a Dashboard on page 81.

Procedure: How to Cascade Prompts

88

When you have more than one prompt on the canvas, you can cascade prompts to populate
them based on the selections of the previous prompts. Cascading prompts have a parent-child
relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of
more than one prompt.

1.

Create an active dashboard in Document mode, or open an existing dashboard, and bind
at least two active prompts to fields.

Right-click the active dashboard prompt that you want to configure, and click Properties.
The active dashboard properties dialog box opens.
Click Cascades.

By default, a cascade named Cascadel appears in the Cascades section of the active
dashboard properties dialog box.

. You can click the Create a new cascade “* button to create a new cascade.
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.4 You can click the Delete selected cascade A button to delete the selected cascade.
4. Select the cascade to which you want to add prompts.

From the Available Prompts list box, select the prompt that you want to add.
6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

Note: You can remove prompts from the Selected Prompts list box by selecting them and
clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and
6.

By default, the hierarchy of the prompts is determined by the order in which they are
added to the Selected Prompts list. The cascade of the prompts is from top to bottom.
The prompts that come first in the Selected Prompts list are the parents of the lower
prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt
list box and clicking the Move Up and Move Down arrows.

9. Click OK.
The cascade is created.
10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the
one that filters the report.
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Chapter

Using Slicers

Slicers provide a quick and easy way to add dynamic user controls to a chart, report or
document, giving you the ability to filter the data in use as you create or view content.
Slicers are dynamic filters that can be changed by making a selection from a menu of
fields. You can use them to filter your content by modifying a slicer in the Slicers tab and
running the chart or report, or you can use them at run time when running a report in
InfoMini with the Slicers tab selected.

In this chapter:
.4 Creating Slicers
.4 Filtering With Slicers

.4 Edit Slicers Dialog Box

Creating Slicers

You can create slicers by dragging fields to the Slicers tab or through the context menu of a
field.

Note: If you are working in Chart mode in App Studio, slicer functionality is not available.

When you create a slicer group, it appears on the Slicers tab, as shown in the following image.

DI._.'H{'? G B @ sprun-

. Home Format Data | Slicers | Layout \iew Series
{#: New Group Preview 500 =
# Clear slicers Drag Fields Here to
%) Update Preview I All v Create Slicers
Options Ta Record Limit la Group 1 Ta

You can use slicers to dynamically filter reports at design time.

You can dynamically filter reports at run time when they are included in an InfoMini application.
For more information on InfoMini, see Building InfoMini Applications on page 103.
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Procedure: How to Create a Slicer
1. Click the Slicers tab.
2. Create a new slicer by using one of the following methods:
- Click the New Group button to create a new slicer group.

Select a field from the Data pane and drag it onto the Drag Fields Here to Create Slicers
text on the Slicers tab.

Note: You cannot drag parent-child hierarchies onto the Slicers tab.
The field is added to the new group.
or

.4 Right-click a field in the Data pane, point to Slicers, and then click New Group, as
shown in the following image.

; Data - wf_retail_lite |-1|] Query
Search fields 2 d |.1|] Chart (wf_retail_lite)

Query Variables 4 im Matrix

4 Measures EE Rows
Sales jjj Columns
Shipments 4 [l axis

4 Dimensions M\u’ertical Axis
Sales_Related I;L! Harizontal Axis
Preduct 4 [iin] Marker
Shipment_Related s Color
Store 'E Size

4 Cystomer #2] Tooltip

Customer Burinars Baninr filf Multi-graph

B Customer,BL Z sum Animate

_.y; Customer,Cc % Create Group...
%5 Customer,St ] Add To Query »
=‘HE Customer,Cit 'r Filter

==Hi Customer,Pc
B Eull Mame

Values

a
d

f Slicers b i New Group

|
L

-
'

#1 Existing Group

The field is added to the new group.
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If you are creating a slicer on a full date field, a calendar icon displays adjacent to the
field. You can use this icon to select a date using a calendar control, as shown in the
following image.

Eﬁ New GFCLII'_'I Prewview 500 - Eale;:ate s
ﬁ[lear Slicers EI v @
fﬁl& Update Preview LT All b # 4 September 2017 » »
Options T Record Limit = Sun Mon Tue Wed Thu Fri Sat
3 Data - wi_retail_lite [ul] Query 27 28 29 30 31 1 2 gy
< 3 4 5 7 i1 9
Search fields ju) d E] Chart (wf_retail_lit 6
Query Variables 4 £ Matrix 10 11 12 13 14 15 15
4 Measures EE: Rows 17 18 19 20 21 22 23
daa
Sales JlColumns | 54 35 26 27 28 29 30
Shipments 4 Mﬂxis 7 @ 2
1 I 2 —} b L] ?
4 Dimensions [Lﬂ\"ertical R
Sales_Related I;.!.! Harizontal Today

Procedure: How to Add a Field to an Existing Slicer Group
1. Click the Slicers tab.
2. Add a field to an existing slicer group using one of the following methods:
- Select a field from the Data pane and drag it onto an existing slicer group.

or

.4 Right-click a field in the Data pane, point to Slicers, and then click Existing Group.
Select an existing group from the menu, and then click OK.

The field is added to the existing group. For more information, see Group Tab on page
101.

Procedure: How to Add a Hierarchy as a Slicer Group
Note: You cannot drag parent-child hierarchies onto the Slicers tab.
1. Click the Slicers tab.

2. Add a hierarchy as a slicer group using one of the following methods:

. Select a hierarchy from the Data pane and drag it onto an existing slicer group.
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The hierarchy is added as a new group, not as a slicer in the existing group. The new
group is given the same name as the hierarchy.

or

Click the New Group b

utton to create a new slicer group.

Select a hierarchy from the Data pane and drag it onto the Drag Fields Here to Create
Slicers text of the Slicers tab.

The hierarchy is added to the new group. The name of the new group changes to the
name of the hierarchy automatically. For example, if you create a slicers group using
the Product hierarchy, Product,Category, Product,Sub,Category, and Model are added
and the group is automatically named Product.

) DGde @8 B gw-
| Home Format Data | Slicers | Layout  View Series
5 Niew Group Preview 500 - Product, Catzgory Product,Subcatzgory
%9 Clear Slicers = =2 = =2 =
W Update Preview HTUILE Al i
Options 71 Record Limit F} Product
3 Data - wi_retail_lite [al) Query 4 Live Preview (500 Records)
Search fields 2 - |:_|] Chart (wf_retail_lite)
Query Variables o 5 Matrix 50
=
4 Measures 4= Rows
’rT)
Sales 111 Columns
Shipments o Mﬁxis
4 Dimensions M\l’er‘tical Auis
sales_Related lidl Horizontal Axis
4 Product a [ Marker

Product, Category
2 Product, Subcategory
3 Model

40

% Calor
B size

2] Tooltip

wl

Note: Hierarchies cannot be added to existing slicer groups. If a hierarchy is dragged onto
an existing slicer group, a new group is created automatically.

There is no right-click context menu for hierarchies. To add a hierarchy as a slicer group,
you must drag it into a new slicer group.

Filtering With Slicers

Once you add slicers to an InfoAssist+ report, you can use them to filter the report. You can
select values from the slicers menus, change the number of records that appear, create new
slicer groups, clear existing slicer groups, and update the report preview.
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Slicers that are not selected have their values filtered by the selected slicers. Only values that
meet the criteria for previously selected slicers will appear in the menu for the next slicer.
Slicers are not filtered in the order they appear in the slicer group, but by the order they are
selected. Cascading of slicers is only valid for hierarchies.

Procedure: How to Change the Relationship Operator in a Slicer

1. With at least one slicer added to the report, click the Slicers tab.
2. Click the operators button on the slicer for the operation you want to change.

A list of operators (numeric) appears in the menu.
Note: Alpha fields just flip between equal and not equal.
3. Select the operator that you want from the menu. You can rest the mouse on an operator
to display a tooltip describing the operation.
How Slicers Cascade Together

Slicers cascade within a hierarchy (cube or dimension builder-based), rather than in the order
of user interaction, eliminating potential performance issues.

Procedure: How to Cascade Slicers

Controls with fields from the same hierarchy are cascaded together.
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In the following example, a report has been created that shows the quantity of products, by
category, sold each year.

Product Sale Quantity
Category Year Sold
Accessories 2014 63,836

2015 139,877
2016 209 571
Camcorder 2014 56,782
2015 123,872
2016 187,033
Computers 2014 34 626
2015 89 626
2016 188,736
Media Player 2014 92 435
2015 198,311
2016 315,783
Stereo Systems 2014 138,850
2015 302717
2016 451,751
Televisions 2014 11,542
2015 24 940
2016 38,123
YWideo Production 2014 25,032
2015 54,853
2016 81,585

1. Create a report.
2. Create multiple slicer groups, as described in How to Create a Slicer on page 92.

In the following example, two groups have been created for this report: Product and Time
(Sales). Both are from hierarchies, so they will cascade.

@ OcH &8 B ww

Format Data | Shicers | Layout  View Series

Preview N - Product Category Product Subcategory Sale,Vear Sale,Quarter

Options Record Limit 1% Product m Time (Sales)
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In the next example, Televisions is selected as the first control for the Product group.

Note: You can select multiple values by holding down the Ctrl key while selecting items in
the drop-down list box. In cases where multiple items are selected, the label for the drop-
down list is set to Multiple. You can click the drop-down list to review the selections.

Product, Category Product, Subcategory
=l = = = =
xr Product,Category y)(
Accessories
Camcorder
Computers

|
= Madia Flayer
Stereo Systems
5 -
Televisions l},
" Video Production

Tie 3

iz

" 0K (3 Cancel

Once you click OK, the new control appears in the drop-down menu.

Product,Category’- BB SN R
=| : Televisions E} — v

Product P

The 1 prior to the decimal point indicates that this is the first cascade you have interacted
with. The 1 after the decimal point indicates that it is the first control in that cascade.

Db2 Web Query InfoAssist+ Part 2 97



Filtering With Slicers

In the next example, Flat Panel TV is selected as the second control for the Product group,
as shown in the following image. This is filtered to only show subcategories for

Televisions.
Product, Category!-! Product, Subcategoryl-2 Sale,Year?!
EI Televisicns - EI Flat Panel TV EI 2017 - EI
r Product, Subcategory ﬁx
Prc CRT TV Si
'&_r'l Flat Panel TV
Portable TV
etail_lite)
s
umns
tical Axis »
izontal Axis
" 0K (8 Cancel
FINy |

Flat Panel TV appears in the Product Subcategory drop-down menu.
The number 1.2 indicates that this is the second control for the first cascade.

Now, a second group, Time (Sales) is created. It has two controls: the first is Sale,Year
and the second is Sale,Quarter.

3. Filter the report using the controls in the slicer groups that you created.

In the following example, the report has been filtered to show the number of flat panel
televisions that were sold in the first quarter of 2017.

Home Format Data | S View
T New G . 9 22
. vew Group Preview 500 - Product, Category™* Product, Subcategory™Z sale,year?? Sale Quarter®2
# Clear Slicers =] [Televisions  [+] =] [FlatPanel v [+| | = [2007 =l = [ -
T Update Preview | RN Tme | Al -
Options & Record Limit ~ fa Product [ Time (Sales) B
3 Dsta - wf_retail lite E) Query 7 Live Preview (500 Records)
Search fields £ | 4 [E) Report (wf_retai_lite)
Query Variables 4 E sum )
4 Measures B Quantity,Sold Product Product Sale  Quantity
Sales « Hpy Category Subcategory  Year Sold
Shipments B Product,Category Televisions FlatPanel TV 2017 9,490
4 Dimensions B ProductSubcategory
4 Sales_Related B Sale,Year
4 Transaction Date, Simple = Across
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Note: The order of a cascade is dynamic. For example, if you selected Camcorder from
Product Subcategory first, then the Product Category control would have a value of Video
Production.
Edit Slicers Dialog Box
You can access the Edit Slicers dialog box by clicking the edit button next to the group labels

on the Slicers tab, as shown in the following image.

Product, Category™ Product, Subcategoryl-2 :

EI Televisions - EI Flat Panel TV w EI

Group 1 P

k., S e
W Live Preview (500 Record T

The Edit Slicers dialog box contains the following tabs:
4 General
.d Record Limit

. Group # (tab for each slicer group)

General Tab

Use the General tab to show or hide the Options group and to automatically update the
Interactive preview. You can also reorder or delete existing groups on this tab.
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The General tab is shown in the following image.

2 Edit Slicers o x
General . Genera
Record Limit #| Show Opticns group
Auto Update Preview
Product
Time (Sales) Group Order

Edit Group Order

Group Hide & Bxclude

%Pruduct
Ir4ﬁTime(Sales}

" OK (S Cancel 2 2pply

The General tab contains the following options:

d Show Options group. Select this option to display the Options group on the Slicers tab.

The Options group contains the following options:
-1 New Group. Adds a new slicers group to the Slicers tab.
.d Clear Slicers. Clears all selected values from existing slicers.

.d Update Preview. Updates the design time canvas with any changes that have been
made.

d Auto Update Preview. Enables auto updating of the canvas.
- Edit Group Order. Select a group, then use the up and down arrows to change its position.

J Hide & Exclude. Select a group, then select this option to hide and exclude the group.
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Note: To delete the group completely, select the group and click Remove from List.

Record Limit Tab

Group Tab

Use the Record Limit tab to show or hide the Record Limit group, the Preview control, and the
Run Time control. You can also use this tab to select the number of preview and run-time
records that will be shown.

The Record Limit tab contains the following options:

.4 Show Record Limit group. Select this option to display the Record Limit group on the

Slicers tab.

The Record Limit group contains the following menus:

-1 Preview. Use this menu to control how many records are displayed in the design-time
preview.

. Run Time. Use this menu to control how many records are displayed at run time.

Show Preview control. Select this option to display the Preview menu in the Record Limit
group on the Slicers tab. You can set the default number of records to be shown at design
time with the Records menu in the Preview section.

Show Run Time control. Select this option to display the Run Time menu in the Record
Limit group on the Slicers tab. You can set the default number of records to be shown at
run time with the Records menu in the Run Time section.

Use the Group tab to change the name of the group, change the order of the slicers in the
group, and set a required option for slicers. Selecting a slicer and clicking the Remove from
List button deletes the slicer.

The Group tab contains the following options:

-

_I

Group Name. Use this field to enter or edit the name of a Slicer group.
Edit Slicer Order. Select a slicer, then use the up and down arrows to change its position.

Required. Select this option to set a slicer to be required. A slicer that is set to required
must have a value selected before the report can run. A required slicer is indicated by an
asterisk (*).
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Chapter

Building InfoMini Applications

InfoMini applications are built from an InfoAssist+ report and contain a subset of
InfoAssist+ functionality available at run time.

You can build an InfoMini application and provide the run-time user with the option to
interact with and edit the report.

In this chapter:

d  Understanding InfoMini Applications

.4 Creating an InfoMini Application

Understanding InfoMini Applications

When you create a report in InfoAssist+, you have the option to activate InfoMini. You can run
a report with InfoMini activated, which creates an InfoMini application. An InfoMini application
contains a subset of the functionality available in the full version of the report or chart

interface. You can limit or expand the functionality that is available to the user at run time

when you build the report or chart in InfoAssist+.

An InfoMini application opens in its own browser window when it is run from within InfoAssist+.

An InfoMini application has many of the components an InfoAssist+ report has, with the
following exceptions:

_I

L U o oo U

The main menu is not accessible.

The New, Open, and View code buttons on the Quick Access Toolbar are not available.

Certain tabs and groups are unavailable or limited.
The status bar is not accessible.
The navigation taskbar is not accessible.

InfoMini does not support referencing existing procedures.

For more information on the available components and their functionality, see InfoAssist+
Application Window.
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Using the InfoMini Button

104

The InfoMini button can be found on the Format tab, in the Destination group. You can click
the InfoMini button to activate the InfoMini option. With the InfoMini button active, you can run
a report to open the InfoMini application.

To deactivate the InfoMini option, click the InfoMini button again. There must be at least one
option selected from the InfoMini button menu for InfoMini to be activated.

You can set the options available to the user at run time from the menu on the InfoMini
button. If you select an option from the menu when the InfoMini button is inactive, the InfoMini
option is activated. The options are:

- Format Tab
- Slicers Tab

d Run Immediately

When you select an option from the menu, a check mark appears next to the option. The check
mark indicates the option is available for the user at run time within the InfoMini application. If
you select a checked option to clear it, the check mark disappears, and the option is no longer
available through the InfoMini application. If you clear all of the options from the menu,
InfoMini is deactivated. All options are selected by default.

The Run Immediately option enables reports to run immediately when InfoMini first launches.
You might want to clear this option so that the user can choose a format and pick slicers
before running a report.

Understanding the InfoMini Layout

The InfoMini layout is similar to the InfoAssist+ layout. The options that are available in
InfoMini vary based on what you select from the InfoMini menu in InfoAssist+. Since it is
customized, the InfoMini ribbon contains subsets of the InfoAssist+ ribbon.

Ribbon
This section defines the tabs on the InfoMini ribbon.

Depending on the options that you enable for InfoMini in InfoAssist+, the tab options vary.

Format Tab

In Edit mode, the following groups display for reports on the Format tab: Output Types and Auto
Linking. For charts, the following additional groups display: Chart Types, Labels, and
Interactive.

IBM



7. Building InfoMini Applications I

In InfoMini mode, the Format tab has the following exceptions:

.4 The Destination and Features groups, which are on the Format tab in InfoAssist+, are not
available in an InfoMini application. The Navigation group is available for charts only.

.4 The Other button, which is on the Format tab, in the Chart Types group in InfoAssist+, is
not available in an InfoMini application.

The Output Types group contains commands to create output in any of the supported formats.

For reports and charts, you also have access to the Auto Linking group. This group contains
options for enabling the functions of Auto Linking, a feature that allows you to create a suite of
referenceable reports or charts in your Enterprise.

For more information on the functionality of the available groups on the Format tab, see Format
Tab.

Slicers Tab

In Edit mode, the following groups display on the Slicers tab: Options, Record Limit, and Group
1.

In InfoMini mode, the Slicers tab has the following exceptions:

.d The Update Preview option, which is on the Slicers tab, in the Options group in InfoAssist+,
is not available in an InfoMini application.

.4 The Preview list, which is on the Slicers tab, in the Record Limit group in InfoAssist+, is not
available in an InfoMini application.

For more information on the functionality of the available groups on the Slicers tab, see Slicers
Tab.
Creating an InfoMini Application

To create an InfoMini application in InfoAssist+, build a report as you normally would, then
activate InfoMini and add the functionality you want the user to have available to them at run
time. For more information on what functionality is available to InfoMini applications, see
Understanding InfoMini Applications on page 103.

Procedure: How to Activate InfoMini
1. With a report or chart open, click the Format tab.

2. In the Destination group, click InfoMini.
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Procedure:

Procedure:

Procedure:

106

Note: At least one option from the InfoMini menu must be selected in order to activate
InfoMini. By default, the Format tab and Slicers tab are selected on the menu when you
activate InfoMini in a new report. For more information on enabling InfoMini options, see
How to Enable and Disable InfoMini Application Options on page 106.

The InfoMini button is highlighted and the InfoMini mode is activated. For more information
about running an InfoMini application, see How to Test an InfoMini Application on page
106.

How to Enable and Disable InfoMini Application Options

You can choose which options will be available at run time in an InfoMini application. By
default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in
a new report. For more information about the functionality of each option, see Understanding
InfoMini Applications on page 103.

1.
2.

With a report or chart open, click the Format tab.
Click the arrow next to the InfoMini button. A menu of available tabs and options displays.

InfoMini does not have to be active for you to access the menu. When you select an
option from the menu, InfoMini is activated.

From the menu, select any options you want to display in your InfoMini application.

How to Test an InfoMini Application

1.

With an InfoAssist+ report open, activate InfoMini as described in How to Activate InfoMini
on page 105.

Enable the options that you want, as described in How to Enable and Disable InfoMini
Application Options on page 106.

Run the report.

An InfoMini application opens in a new window.

How to Interact With an InfoMini Application

You have the ability to alter the InfoMini application at run time using the Interactive mode.
Changes to the application are not reflected on the canvas dynamically and you must run the
report to see the updates.

1.

Run a report with InfoMini activated, as described in How to Test an InfoMini Application on
page 106.

An InfoMini application opens in a new window.
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2. By default, the ribbon is hidden in an InfoMini application. To display the ribbon, do one of
the following:

-1 In Interactive mode, click one of the tabs.

.4 Click the down arrow next to the Help icon.

The available options on these tabs provide the same functionality as they do in InfoAssist
+. You can use this embedded functionality to change the report at run time.

3. After making your changes, click Run to see an updated version of the report.
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Chapter

Ribbon Command Reference

The ribbon is contextual and changes depending on the type of file that you are
developing. This topic describes each of the available ribbons and commands for each

InfoAssist+ tool.

In this chapter:

.4 Ribbon Commands for Reports

Ribbon Commands for Charts

|
.d  Ribbon Commands for Documents
|

Ribbon Commands for Visualizations

Ribbon Commands for Reports

When creating and customizing reports in Report mode, you can use the following ribbons and
commands to customize report functionality.

Home Tab

Command

Description

Format Group

Output File Format

Displays a drop-down menu of all supported output
formats.

Chart Switches to Chart mode. Converts a report to a chart
using the fields specified in the report.

Report Indicates that you are in Report mode.

File Creates a data file from a report.

Design Group
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Command Description

Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the report.

Live Preview (Design view) Displays the report on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the report.

Document (Design view) Converts a report into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Data from Source Uses the selected data source to display a live preview
of the output on the canvas.

Use Sample Data Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.

Records Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude Turns off a filter.

Include Turns on a filter.

Report Group
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Command

Description

Theme

Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.

Style

Opens a Report Style dialog box for applying global
styling to the entire report. For more information about
styling reports, see Styling Reports.

Banded

Opens a Color dialog box for choosing a color that
provides an alternating color scheme for the report. The
report output displays alternating rows of data, using a
white background for one row and a background of the
selected color for the next row. This pattern continues
throughout the report.

Header & Footer

Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals

Adds a grand total row to the bottom of the report to sum
numeric data in each column.

Row Totals Adds a grand total column to the right side of the report
to sum numeric data in each row.
Format Tab
Command Description

Destination Group
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Command Description

InfoMini Enables the creation of an InfoMini application. For more
information on using InfoMini, see Building InfoMini
Applications on page 103.

Chart Switches to Chart mode. Converts a report to a chart
using the fields specified in the report.

Report Indicates that you are in Report mode.

File Creates a data file from a report.

Navigation Group

Table

Generates standard browser output. This is the default.

Table of Contents

Generates output by displaying a table of contents icon
in the upper-left corner where report output typically
appears. Clicking Table of Contents opens a menu that
enables you to select (view) individual values of the first
Sort By (By) field, one value at a time.

You can also select options to view the entire report or
remove the table of contents.

Freeze

Generates output with column titles that freeze (remain
in view) when you scroll through pages of the report
output.

Pages On Demand

Provides access to two distinct features, depending upon
the output type that you have selected.

OLAP Analysis

Enables Online Analytical Processing capabilities for
online reports, including showing or hiding the OLAP
panel. You can select from different options using the
drop-down menu on the split button.

Features Group

Title Popup

Displays pop-up titles when the mouse pointer hovers
over a column title in the report output.
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Command

Description

Accordion

Creates expandable views of data for each vertical sort
field. This option displays data values only for the first
vertical sort field when you first view the output. You can
manually expand your view to expose the data values of
lower-level sort fields.

Repeat Sort Value

Displays all repeated sort values instead of blanks in the
output after the first instance of a new sort value, which
is the default behavior.

Stack Measures

Displays all numeric measure field names in a column of
the report output with the corresponding numeric data
values.

active report Options

Opens the active report options dialog box where you can
configure your active report options such as menu items,
graph engine, and colors. For more information, see
Creating Active Technologies Components With InfoAssist+
on page 55.

Accessibility

Allows a title to be added to a report, chart, or document
that is Section 508-compliant.

Run with Group

Auto Dirill

Enables you to navigate through different levels within
the dimension hierarchy of your data source. Click Auto
Drill to enable the functionality. For more information,
see Using Auto Drill.

Auto Linking Group

Enable Auto Linking

Enables auto linking. For more information, see Using the
Auto Linking Feature to Link Content.

Auto Link Target

Sets procedure as an available target for auto linking.
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Data Tab
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Command

Description

Calculation Group

Detail (Define)

Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute)

Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a name for the
field, and enter a format.

Join Group

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to a join.

Filter Group

Filter Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Display Group

Missing Data This option is disabled for reports.

Data Source Group

Add

Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document. This option is activated when you add a HOLD
file. This option is unavailable, by default.
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Slicers Tab

Command Description

Switch Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.
This option is activated when you add a HOLD file. This
option is unavailable, by default.

Command Description

Options Group

New Group

Creates a new group of similar slicers.

Clear Slicers

Resets all slicers so that no filtering is done.

Update Preview

Applies slicers to preview.

Options

Opens the Edit Slicers dialog box to the General tab,
where you can set general options for your slicers.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Record Limit Opens the Edit Slicers dialog box to the Record Limit tab,

where you can set record limits for your slicers.

Group Number Group

Group n

Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers. To access slicer group options,
click Group n to open the Edit Slicers dialog box where
you can rename the slicer group and modify the order of
the slicers in the group.
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Layout Tab

Command

Description

Page Setup Group

Margins

Enables you to set margin values by choosing Normal (1
inch all around), Narrow (.5 inch all around), Moderate (.5
inch left or right), Wide (1.5 inch left or right), or Custom.
Choosing Custom opens the Margins dialog box, where
you can set specific margins as needed.

Orientation

Enables you to set the orientation of your report to
portrait or landscape.

Size

Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units

Enables you to select the unit of measurement used for
customizing the dimension fields of your report. You can
choose Inches, Centimeters, or Points.

Page Numbers

Enables you to select page numbering options. You can
choose one of the following:

.4 No Lead (no space for headers)
.4 On (page numbers only in headers)
4 Off (space for headers, but no page numbering)

The Page Numbers value is overridden by header and
footer text options.

Report Group

Cell Padding

Opens the Cell Padding dialog box, where you can set
specific values to control the amount of space inserted
between rows and columns in a report. For more
information, see Use Cell Padding in a Report.
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Command Description
AutoFit Limits the width of columns in a report to be no wider
than the largest value in each column. AutoFit Column is
selected, by default.
View Tab
Command Description

Design Group

Query (Design view)

Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the report.

Live Preview (Design view)

Displays the report on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the report.

Document (Design view)

Converts a report into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Show/Hide Group

Resources

Minimizes the Resources panel and expands the size of

the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Data Panel Group

Logical

Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.
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Command

Description

List

Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured

Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

Areas 2x2 Displays data in a two column by two-row grid.
Areas 1x4 Displays data in a one column by four-row grid.
Tree Displays data in a tree. This is the default.

Output Window Group

Arrange

Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.

Output Location

Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output

Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report

Lists any active reports, charts, documents, and visuals
to which you can switch.
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Field Tab

Command

Description

Filter Group

Filter

Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude

Removes, but does not delete, the filter from the report.

Include

Restores a filter that was previously excluded from a
report.

Prompt

Opens the Create a filtering condition dialog box for
creating an auto prompting parameter that you can select
when you run a report. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

- Simple. This is used for prompts using Text Input.
This is the default value.

. Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

-1 Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

.4 Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up

Sorts the selected field in ascending order. This option is
activated when you click on a measure or dimension.
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Command

Description

Down

Sorts the selected field in descending order. This option
is activated when you click on a measure or dimension.

Rank

Inserts a rank column immediately to the left of the
report if a Sort By field is selected. It also adds a rank
column to the left of the Sort By field if a Measure field is
selected. Ranking a Measure field results in two copies
of the field, the original Measure field, and the Sort By
field that is created during ranking. This option is
activated when you click on a measure or dimension.

Group

Opens the Create a Group dialog box where you can
create a group to combine values together. This option is
activated when you click on a dimension.

Limit

Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added. This option is activated when you click
on a measure or dimension.

Break Group

Page Break

Starts a new page when the primary sort field changes.
Clicking the drop-down icon enables you to select Reset
Page Numbers, which allows you to reset page numbers
on a page break to start at 1. This option is activated
when you click on a dimension.

Line Break

Inserts a line in the report output when the primary sort
field changes. This option is activated when you click on
a dimension.

Subtotal

Inserts a line, total text (TOTAL FIELD Value), and
subtotals for all numeric fields when the primary sort
field changes. This option is activated when you click on
a dimension.

120

IBM



8. Ribbon Command Reference I

Command Description

Sub Header Opens a dialog box where you can type text to add a
subheading just below the column titles in the report
output when the primary sort field changes. This option is
activated when you click on a dimension.

Sub Footer Opens a dialog box where you can type text to add a
subfooting at the end of the data on each page of the
report output when the primary sort field changes. This
option is activated when you click on a dimension.

Style Group

Font Opens the Font list, which you can use to change the
font.

Font Size Opens the Font Size list, which you can use to change
the numeric value for the font size.

Font Color Opens the Color dialog box, where you can select the
font color.

Style Reset Resets all settings to the default settings from the
template.

Bold Applies bold font formatting to the selected text.

Italic Applies italic font formatting to the selected text.

Underline Underlines the selected text.

Justify Left Aligns the text to the left of the report.

Justify Center

Aligns the text to the center of the report.

Justify Right

Aligns the text to the right of the report.

Background Color

Opens the Color dialog box, where you can select the
background color for the report.

Data Style

Styles only the data for the selected data source field.
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Command Description

Title Style Styles only the column title for the selected data source
field.

Data + Title Styles both the data and the column title for the selected

data source field.

Format Group

Decimal

The default value for the data format of the selected
measure is Decimal. Use the drop-down menu to select
Alphanumeric, Integer, or More options to open the Field
Format Options dialog box.

Change currency options

Changes the currency options for the selected field. This
option is activated when you click on a measure.

Percent Specifies the value of the field as a percentage. This
option is activated when you click on a measure.
Comma Specifies the use of commas for the selected field. This

option is activated when you click on a measure.

Increase Decimal Places

Increases the number of decimal places that display for
the selected field. This option is activated when you click
on a measure.

Decrease Decimal Places

Decreases the number of decimal places that display for
the selected field. This option is activated when you click
on a measure.

Display Group
Hide Field Allows you to hide a selected field.
Hide Missing Allows you to hide fields that have no value.
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Command

Description

Aggregation

Enables you to apply an aggregation function to a field in
a report. Opens a drop-down menu of the following
options: None (default), Sum, Average, Count, Count
Distinct, Percent of Count, First Value, Last Value,
Maximum, Minimum, Total, Percent, Row Percent,
Median, Average Square.

Traffic Lights

Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down.

Data Bars Adds a data visualization column to the right of a
selected numeric field. The column displays values in
each row using horizontal bars that extend from left to
right in varying lengths, depending on the corresponding
data values.

Within Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column.

Column(s) This option is disabled for reports.

Links Group

Drill Down Opens the Drill Down dialog box, where you can configure

a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure.
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Ribbon Commands for Charts

When creating and customizing charts in Chart mode, you can use the following ribbons and
commands to customize chart functionality.

Home Tab

Command Description

Format Group

Output File Format Displays a drop-down menu of all supported output
formats.

Chart Indicates that you are in Chart mode.

Report Switches to Report mode. Converts a chart to a report

using the fields specified in the chart.

File Creates an image file from a chart. This option is
disabled by default and is only enabled for HTML format.

Design Group

Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the chart.

Live Preview (Design view) Displays the chart on the canvas as you create the chart.
You can use the Live Preview to add, remove, and
arrange fields, as well as style the chart.

Document (Design view) Opens the document on canvas, which you can use to
add text, images, lines, reports, and charts to create
documents.

Data from Source Uses the selected data source to display a live preview

of the output on the canvas.

Use Sample Data Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.
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Command

Description

Records

Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter

Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude

Turns off a filter.

Include

Turns on a filter.

Report Group

Theme

Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.

Style

This option is disabled for charts.

Banded

This option is disabled for charts.

Header & Footer

Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals

This option is disabled for charts.
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Format Tab
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Command Description
Row Totals This option is disabled for charts.
Command Description

Destination Group

InfoMini Enables the creation of an InfoMini application. For more
information on using InfoMini, see Building InfoMini
Applications on page 103.

Chart Indicates that you are in Chart mode.

Report Switches to Report mode. Converts a chart to a report
using the fields specified in the chart.

File Creates an image file from a chart. This option is

disabled by default and is only enabled for HTML format.

Chart Types Group

Bar Changes the chart type to a bar chart.

Pie Changes the chart type to a pie chart.

Line Changes the chart type to a line chart.

Area Changes the chart type to an area chart.
Scatter Changes the chart type to a scatter chart.
Choropleth Changes the chart type to a choropleth map.

Proportional Symbol

Changes the chart type to a proportional symbol (bubble)
map.
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Command Description

Other Opens the Select a chart dialog box. The chart types,
depicted by icons, display on the left side of the dialog
box. The first chart type represents the bar chart
category, which is selected by default. When a chart type
is selected, the dialog box displays thumbnail images of
bar chart variations that are supported.

Map Group

Background Provides terrain options and various other geographical

views. This option only displays when a map is selected
as the chart type.

Demographic Layers

Allows you to apply one or more pre-defined demographic
layers, which can narrow the scope of your data using
these underlying layers of demographic categorization.
This option only displays when a map is selected as the
chart type.

Reference Layers

Enables you to define one or more reference layers,
which creates borders based on your geographical
selection. This option only displays when a map is
selected as the chart type.

Features Group

3D Effect

Sets the three-dimensional view to on or off. The 3D
Effect feature is disabled for 3D, stock, gauge, gauge
thermometer, Pareto, spectral map, and funnel chart
types. This is the default. This option is not available for
maps.

Rotate

Toggles between a vertical display or horizontal display of
a chart. For more information, see Rotate a Chart. The
Rotate feature is disabled for pie, scatter, 3D, stock,
gauge, gauge thermometer, Pareto, spectral map, and
funnel chart types. This option is not available for maps.
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Command Description

Reference Opens a drop-down menu that provides the Add
Reference Line to Y-Axis and Add Reference Line to X-
Axis options. Selecting one of these options opens the
appropriate Reference Line dialog box, where you can set
the specific X-axis or Y-axis value, type the text that you
want, and position the reference line on a chart. For
more information, see Display a Static Reference Line.
The Reference feature is disabled for pie, 3D, stock,
gauge, gauge thermometer, Pareto, spectral map, and
funnel chart types. This option is not available for maps.

Annotate Opens a drop-down menu that provides the Add an
annotation option. Selecting this option opens the
Annotation dialog box, where you can type the text that
you want and position the annotation on a chart. For
more information, see Display Annotations.

The annotation option is not available in HTML5. This
option is not available for maps.

Grid Opens a drop-down menu allowing you to expand options
for Horizontal or Vertical Gridlines. Both selections allow
you to enable or disable Major and Minor Gridlines.
Clicking More Options opens the Format Grid Lines dialog
box. This option is not available for maps. For more
information, see Formatting Gridlines.

Frame & Background Opens the Frame & Background dialog box where you can
edit the background style and frames for charts. The
dialog contains different options depending on the chart
type selected. For more information, see Formatting a
Frame and a Background.

Gauges Opens the Gauge dialog box where you can edit your
gauge chart. This button is only available when a gauge
chart type is selected. This option is not available for
maps. For more information, see Style a Gauge Needle.
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Command

Description

active report Options

Opens the active report options dialog box where you can
configure your active report options, such as menu
items, graph engine, and colors. This button is available
when the output type is set to active report. This option
is not available for maps.

Accessibility

Allows a title to be added to a report, chart, or document
that is Section 508 compliant. This option is available for
reports and charts when the output type is HTML,
HTMLD5, or PDF. This includes JS Charts, which
encompasses any chart that is drawn in an HTML
environment using a defined data set and JavaScript
Option Notation (JSON) definitions.

For documents, the output type must be set to PDF.

The chart features are unavailable when designing a
chart that will be output in active report format.

Labels Group

Axes

Opens a drop-down menu, where you can enable and
rotate horizontal and vertical axis labels, and stagger
horizontal axis labels. You can also edit the axis labels
by clicking More Horizontal Axis Options or More Vertical
Axis Options. For more information, see Format Axis
Labels. This option is not available for maps.

Legend

Opens a drop-down menu, where you can select the
Show Legend option to display the legend on the chart,
or clear your selection to hide the legend, change the
default legend position, and change the default legend
orientation. For more information, see Format Legend
Dialog Box.

Interactive Group
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Command Description

Interactive Options Opens the Interactive Options dialog box, which enables
you to specify animation and mouse over effects in your
chart. This option is only available for HTML5 and active
outputs. This option is not available for maps.

Run with Group

Auto Drill Enables you to navigate through different levels within
the dimension hierarchy of your data source. Click Auto
Drill to enable the functionality.

Note: Auto Drill functionality requires the specification of
at least one dimension sort field in the request.

For more information, see Using Auto Drill.

Auto Linking Group

Enable Auto Linking Enables auto linking.

Auto Link Target Sets procedure as an available target for auto linking.
Data Tab

Command Description

Calculation Group

Detail (Define) Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute) Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a hame for the
field, and enter a format.
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Command Description

Join Group

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to ajoin.

Filter Group

Filter Opens the Filter dialog box, enabling you to set filtering
options. Filter options include Where, Where Total, the
And conjunction, and the Or conjunctions in a single
expression.

Display Group

Missing Data Includes options for how to display missing values in

charts.

Data Source Group

Add

Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document. This option is only enabled if the chart was
created from a HOLD file.

Switch

Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.
This option is only enabled if the chart was created from
a HOLD file.

Slicers Tab

Command

Description

Options Group
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Command Description
New Group Creates a new group of similar slicers.
Clear Slicers Resets all slicers so that no filtering is done.

Update Preview

Applies slicers to preview.

Options

Opens the Edit Slicers dialog box to the General tab,
where you can set general options for your slicers.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Record Limit Opens the Edit Slicers dialog box to the Record Limit tab,

where you can set record limits for your slicers.

Group Number Group

Group n

Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers. To access slicer group options,
click Group n to open the Edit Slicers dialog box where
you can rename the slicer group and modify the order of
the slicers in the group.

Layout Tab

Command

Description

Page Setup Group

Margins

Enables you to set margin values by choosing Normal (1
inch all around), Narrow (.5 inch all around), Moderate (.5
inch left or right), Wide (1.5 inch left or right), or Custom.
Choosing Custom opens the Margins dialog box, where
you can set specific margins as needed.
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Command Description

Orientation Enables you to set the orientation of your report to
portrait or landscape.

Size Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units Enables you to select the unit of measurement used for

customizing the dimension fields of your report or chart.
You can choose Inches, Centimeters, or Points.

Page Numbers

This option is disabled for charts.

Size & Arrange Group

Height

Sets the height of the chart.

Width

Sets the width of the chart.

Auto Overflow

This option is disabled for charts.

Aspect Ratio

Lock the height and width aspect ratio. With the aspect
ratio locked, changing the width automatically changes
the height to keep the component to scale, and changing
the height automatically changes the width.

AutoFit Expands the chart, at design time, when additional fields
are added. At run time, the chart is resized dynamically
to fit into the container in which it is placed. AutoFit is
enabled, by default.

Align This option is available in Document mode only.

Relative Position

This option is available in Document mode only.
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View Tab

Command Description

Design Group

Query (Design view) Displays the Data, Query, and Filter panes across the
entire canvas, eliminating Live Preview. This view
provides a larger work area for creating the chart.

Live Preview (Design view) Displays the chart on the canvas as you create the
report. You can use the Live Preview to add, remove, and
arrange fields, as well as style the chart.

Document (Design view) Converts a chart into a document. Opens the document
on canvas, which you can use to add text, images, lines,
reports, and charts to create documents.

Show/Hide Group

Resources Minimizes the Resources panel and expands the size of

the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Data Panel Group

Logical Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

134 IBM



8. Ribbon Command Reference I

Command Description

Areas 2x2 Displays data in a two column by two-row grid. This
option is disabled for charts that use the new field
container syntax.

Areas 1x4 Displays data in a one column by four-row grid. This
option is disabled for charts that use the new field
container syntax.

Tree Displays data in a tree. This is the default.

Output Window Group

Arrange

Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.

Output Location

Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output

Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report

Lists any active report or chart to which you can switch.

Field Tab

Note: The Format group is disabled in Chart mode.

Command Description
Filter Group
Filter Opens the Filter dialog box for creating filters. Filters

enable you to select only the data that you want and to
exclude unwanted data.
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Command Description

Exclude Removes, but does not delete, the filter from the chart.

Include Restores a filter that was previously excluded from a
chart.

Prompt Opens the Create a filtering condition dialog box for

creating an auto prompting parameter that you can select
when you run a chart. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

.4 Simple. This is used for prompts using Text Input.
This is the default value.

4 Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

.d Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

.4 Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up Sorts the selected field in ascending order.

Down Sorts the selected field in descending order.

Rank This option is disabled for charts.

Group Opens the Create a Group dialog box where you can

create a group to combine values together. This option is
enabled for dimension fields only.
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Command

Description

Limit

Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added.

Format Group

Note: These options are disabled for charts.

Display Group

Hide Field Allows you to hide a selected field.

Hide Missing Allows you to hide fields that have no value. This option
is disabled for charts.

Aggregation Opens a drop-down menu of the following options: None

(default), Sum, Average, Count, Count Distinct, Percent
of Count, First Value, Last Value, Maximum, Minimum,
Total, Percent, Row Percent, Median, Average Square.
This option is only available for measure fields or
dimensions (alpha field only) that are in a numeric field
container. Otherwise, aggregations will not display.

Traffic Lights

Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down. This option is only available for measure
fields.

Data Bars

This option is disabled for charts.

Within

Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column. This
option is disabled for charts.
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Command Description

Column(s) Allows you to indicate the number of columns in which
you wish to display multiple graphs. The value can be
between 1 and 512. The default is 1. This option is also
available from the Query Design pane shortcut menu for
a Multi-graph component. This option is only enabled
when the multi-graph field container is populated.

Links Group

Drill Down Opens the Drill Down dialog box, where you can configure
a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure. This option is available for measure
fields only. If you are working in PDF format, this option is
disabled.

Series Tab

Command Description

Select Group

Series drop-down list Lists the available series in the current chart.

Style Group

Style Opens the Format Series dialog box, where you can edit

the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group
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Command

Description

Data Labels

Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Clicking More Data Label Options opens the Format
Labels dialog box, where you can further edit your data
labels.

Type

Opens a drop-down menu with the following options for
selecting different chart types: None (default), Bar, Line,
and Area.

Note: When you make a change to the chart type using
the Type button on the Series tab, changes to the chart
type on the Format tab are overwritten.

Trendline

Opens a drop-down menu that provides options for
adding a trendline to a chart.

Equation

Displays the associated mathematical equation for the
selected trendline on the chart.

The equation is not available in HTML5.

Line Group

Smooth Line

Draws the chart using smooth lines.

Connect Lines

Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.

Marker

Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see Change the Appearance of a Marker.
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Command

Description

Pie Group

Note: The following options are only enabled when you are working with a pie chart.

Expand

Expands pie slices.

Hide

Hides pie slices.

Ribbon Commands for Documents

When creating and customizing documents in Document mode, you can use the following
ribbons and commands to customize document functionality.

Home Tab

Command

Description

Format Group

Output File Format

Displays a drop-down menu of all supported output
formats.

Chart

Determines whether chart-specific functionality is
available in the InfoAssist+ tool. The default name Chart
(data source) is given for each new chart created in a
given InfoAssist+ session, where data source is the
name of the underlying data source you are using. You
can rename the chart by right-clicking Chart in the Query
pane and clicking Rename.

Report

Determines whether report-specific functionality is
available in the InfoAssist+ tool. The default name
Report (data source) is given for each new report created
in a given InfoAssist+ session, where data source is the
name of the underlying data source you are using. You
can rename the report by right-clicking Report in the
Query pane and clicking Rename.
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Command

Description

File

Creates a data file from a report component of a
document.

Design Group

Query (Design view)

This option is disabled in Document mode.

Live Preview (Design view)

This option is disabled in Document mode.

Document (Design view)

Once you are in Document mode, it is selected by default
in the Design group. The document displays on the
canvas, to which you can add text, images, lines,
reports, and charts.

Data from Source

Uses the selected data source to display a live preview
of the output on the canvas.

Use Sample Data

Displays sample data, which reduces processing time by
eliminating the need to access the actual data source.

Records

Limits the number of rows retrieved from the data source
when Live Preview is selected. This feature is useful in
reducing response time if you are working with a large
amount of data. Type the number of rows that you want
directly in the Records field, or use the drop-down menu
to select one of the preset record limits. The preset
choices are All rows, 1, 10, 50, 100, 500, 1000, 2000,
5000, and 10000.

Filter Group

Filter

Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude

Turns off a filter.

Include

Turns on a filter.

Clipboard Group
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Command Description

Paste Enables you to paste a text, report, or chart object that
you have copied to or placed on the clipboard.

Cut Enables you to cut a text, report, or chart object from
your document, placing it on the clipboard.

Copy Enables you to copy a text, report, or chart object to the
clipboard.
Duplicate Enables you to duplicate a text, report, or chart object in

your document, placing it on the clipboard.

Report Group

Theme Opens a dialog box where you can select a theme to
style your report or chart. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a document styling theme or an
application theme to style all reports created. Use the
Environment and Styling section of the Options window,
which is accessible by clicking Options in the Application
main menu.

Style Opens a Report Style dialog box for applying global
styling to the entire report. This option is disabled for
charts in Document mode. For more information about
styling reports, see Styling Reports.

Banded Opens a Color dialog box for choosing a color that
provides an alternating color scheme for the report. The
report output displays alternating rows of data, using a
white background for one row and a background of the
selected color for the next row. This pattern continues
throughout the report. This option is disabled for charts
in Document mode.

Header & Footer Opens the Header & Footer dialog box, from which you
can add and style headings and footings.
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Command

Description

Column Totals

Adds a grand total row to the bottom of the report to sum
numeric data in each column. This option is disabled for
charts in Document mode.

Row Totals Adds a grand total column to the right side of the report
to sum numeric data in each row. This option is disabled
for charts in Document mode.

Insert Tab
Command Description

Pages Group

Page

Adds a new page to a document.

Reports Group

Report

Inserts a report placeholder on the canvas.

Chart

Inserts a chart placeholder on the canvas.

Existing Report

Opens the Open dialog box, where you can browse to the
report that you want to insert in the upper-left corner of
the canvas.

Objects Group

Text Box Inserts an inline text object in the upper-left corner of the
canvas.
Image Opens the Open dialog box, where you can browse to the

image that you want to insert in the upper-left corner of
the canvas.

active dashboard Prompts group

Drop Down

Inserts a drop-down control placeholder in the upper-left
corner of the canvas.
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Format Tab

144

Command Description

List Inserts a list control placeholder in the upper-left corner
of the canvas.

Checkbox Inserts a check box control placeholder in the upper-left

corner of the canvas.

Radio Button

Inserts a radio button control placeholder in the upper-
left corner of the canvas.

Text Inserts a text area control placeholder in the upper-left
corner of the canvas.
Command Description

Destination Group

InfoMini

Enables the creation of an InfoMini application. For more
information on using InfoMini, see Understanding and
Building InfoMini Applications.

Report

Makes report-specific functionality available. In
Document mode, if you select a report object, the Report
option is enabled on the Home tab and the ribbon
options change. For more information, see Ribbon
Commands for Reports on page 109.

Chart

Makes chart-specific functionality available. In Document
mode, if you select a chart object, the Chart option is
enabled on the Home tab and the ribbon options change.
For more information, see Ribbon Commands for Charts
on page 124.

File

Creates a data file from a report component of a
document.

Navigation Group
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Command Description

Table Generates standard browser output. This is the default.
This option is only available for reports in Document
mode.

Table of Contents Generates output by displaying a table of contents icon

in the upper-left corner where report output typically
appears. Clicking Table of Contents opens a menu that
enables you to select (view) individual values of the first
Sort By (By) field, one value at a time.

You can also select options to view the entire report or
remove the table of contents. This option is unavailable
for charts in Document mode, and is disabled for reports
in Document mode.

Freeze Generates output with column titles that freeze (remain
in view) when you scroll through pages of the report
output. This option is unavailable for charts in Document
mode, and is disabled for reports in Document mode.

Pages On Demand Provides access to two distinct features depending upon
the output type that you have selected. This option is
available for reports in Document mode.

Features Group

Title Popup Displays pop-up titles when the mouse pointer hovers
over a column title in the report output. When working
with reports in Document mode, this option is disabled.

Accordion Creates expandable views of data for each vertical sort
field. This option displays data values only for the first
vertical sort field when you first view the output. You can
manually expand your view to expose the data values of
lower-level sort fields.

Repeat Sort Value Displays all repeated sort values instead of blanks in the
output after the first instance of a new sort value, which
is the default behavior.
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Data Tab
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Command

Description

Stack Measures

Displays all numeric measure field names in a column of
the report output with the corresponding numeric data
values.

active report Options

Opens the active report options dialog box where you can
configure your active report options such as menu items,
graph engine, and colors. For more information, see
Creating Active Technologies Components With InfoAssist+
on page 55.

Accessibility

Allows a title to be added to a report, chart, or document
that is Section 508-compliant.

Run with Group

Auto Drill

This option is disabled in Document mode.

Command

Description

Calculation Group

Detail (Define)

Opens the Detail Field (DEFINE) dialog box, where you
can create a defined field, type a name for the field, and
enter a format. A Define field is an optional attribute
used to create a virtual field for reporting. You can derive
the virtual field value from information already in the data
source (that is, from permanent fields).

Summary (Compute)

Opens the Summary Field (COMPUTE) dialog box, where
you can create a computed field, type a name for the
field, and enter a format.

Join Group
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Command Description

Join Opens the Join dialog box, where you can create a new
join, edit or delete existing joins, and add data sources
to ajoin.

Filter Group

Filter Opens the Filter dialog box, enabling you to set filtering
options. Filter options include Where, Where Total, the
And conjunction, and the Or conjunctions in a single
expression.

Display Group

Missing Data Includes options for how to display missing values in

charts.

Data Source Group

Add

Opens the Open dialog box, where you can add additional
data sources to a document, enabling you to insert
reports from different data sources into the same
document.

Switch

Opens a drop-down list of all the data sources that have
been added. You can choose which data source is
currently active and being used to create new reports.

Slicers Tab

Command

Description

Options Group

New Group

Creates a new group of similar slicers.

Clear Slicers

Resets all slicers so that no filtering is done.

Update Preview

Applies slicers to preview.
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Command Description

Options Provides access to the Edit Slicers dialog box. For more
information, see Using Slicers on page 91.

Record Limit Group

Preview Sets the number of records retrieved from the data
source for preview.

Run Time Sets the number of records retrieved at run time.

Record Limit Provides access to the Edit Slicers dialog box, where you
can modify record limit settings. For more information,
see Using Slicers on page 91.

Group Number Group

Group n Contains a group for each Slicer group that is added.
Group 1 is the default slicer group to which you can drag
fields to create slicers.

Layout Tab

Command Description

Page Setup Group

Margins This option is disabled in Document mode.

Orientation Enables you to set the orientation of your report to
portrait or landscape.

Size Enables you to select the size of the paper for printing
output. You can choose A3, A4, A5, Letter, Tabloid,
Legal, PowerPoint, or Large Size (34 x 44 Inches).

Units Enables you to select the unit of measurement used for
customizing the dimension fields of your report or chart.
You can choose Inches, Centimeters, or Points.
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Command

Description

Page Numbers

Enables you to select page numbering options. You can
choose one of the following:

- No Lead (no space for headers)
.4 On (page numbers only in headers)

.4 Off (space for headers, but no page numbering)

The Page Numbers value is overridden by header and
footer text options.

Size & Arrange Group

Height

Sets the height of the selected document component.

Width

Sets the width of the selected document component.

Auto Overflow

Automatically expands the query area to show all data.

Aspect Ratio

Lock the height and width aspect ratio.

AutoFit

In Document mode, this option is disabled.

Align

Opens a drop-down menu of available alignment options,
when two or more document components are selected.

Relative Position

Positions the top-left corner of the lower component, to
the bottom-left corner of the higher component, when two
or more document components are selected.

Size and Arrange

Opens the Size and Position dialog box where you can
set size and position options for the object in your
document.

Report Group

Cell Padding

Opens the Cell Padding dialog box, where you can set
specific values to control the amount of space inserted
between rows and columns in a report. For more
information, see Use Cell Padding in a Report.
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View Tab
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Command

Description

Autofit Column

When working with a report component, this option
automatically compresses the columns in the report to
the width of the widest data instance. Autofit Column is
selected, by default.

Command

Description

Design Group

Query (Design view)

This option is unavailable in Document mode.

Live Preview (Design view)

This option is unavailable in Document mode.

Document

Enables Document mode by default.

Show/Hide Group

Resources

Minimizes the Resources panel and expands the size of

the canvas to also occupy the area where the Resources
panel typically appears. The canvas can display a preview
of a report, output of a report, or the Query Design pane.

Ruler

Displays a ruler above the canvas and to the left of the
canvas for a document.

Grid

Displays a grid as a visual aid for aligning objects in a
document.

Relationships

Shows the relative positioning relationship among
objects.

Data Panel Group

Logical

Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.
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Command

Description

List

Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured

Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Query Panel Group

Areas 2x2

Displays data in a two column by two-row grid. When
working with the new field container syntax, this option is
unavailable.

Areas 1x4

Displays data in a one column by four-row grid. When
working with the new field container syntax, this option is
unavailable.

Tree

Displays data in a tree. This is the default.

Output Window Group

Arrange

Opens a drop-down menu where you can choose how to
display multiple output windows. The options are
Cascade, Tile Horizontally, and Tile Vertically.

Output Location

Opens a drop-down menu where you can choose how to
direct new output. The options are Single tab (default),
New Tab, Single Window, and New Window.

Switch Output

Opens a drop-down menu for choosing to view any active
output window.

Report Group

Switch Report

Lists any active report or chart to which you can switch.
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Field Tab
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Command

Description

Filter Group

Filter

Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.

Exclude

Removes, but does not delete, the filter from the report
or chart.

Include

Restores a filter that was previously excluded from a
report or chart.

Prompt

Opens the Create a filtering condition dialog box for
creating an auto prompting parameter that you can select
when you run a report. The Create a filtering condition
dialog box is used to create both filters and auto
prompting parameters. The following prompt options are
available when Parameter is selected from the Type drop-
down menu:

.4 Simple. This is used for prompts using Text Input.
This is the default value.

4 Static. This is used for prompts using Selection. This
option allows you to select multiple values at run
time.

.d Dynamic. This is used for prompts using Data Values.
This option allows you to select multiple values at run
time.

.4 Optional. This is used for prompts using Single or
Multiselect parameters.

Sort Group

Up

Sorts the selected field in ascending order.

Down

Sorts the selected field in descending order.
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Command

Description

Rank

Inserts a rank column immediately to the left of the
report if a Sort By field is selected. It also adds a rank
column to the left of the Sort By field if a Measure field is
selected. Ranking a Measure field results in two copies
of the field, the original Measure field, and the Sort By
field that is created during ranking.

Group

Opens the Create a Group dialog box where you can
create a group to combine values together.

Limit

Opens a drop-down menu that allows you to specify the
number of unique values to display for a sort group that
has been added.

Break Group

Page Break

Starts a new page when the primary sort field changes.
Clicking the drop-down icon enables you to select Reset
Page Numbers, which allows you to reset page numbers
on a page break to start at 1.

Line Break

Inserts a line in the report output when the primary sort
field changes.

Subtotal

Inserts a line, total text (TOTAL FIELD Value), and
subtotals for all numeric fields when the primary sort
field changes.

Sub Header

Opens a dialog box where you can type text to add a
subheading just below the column titles in the report
output when the primary sort field changes.

Sub Footer

Opens a dialog box where you can type text to add a
subfooting at the end of the data on each page of the
report output when the primary sort field changes.

Style Group

Note: The options in this group are only available for reports in Document mode.
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Command Description

Font Opens the Font list, which you can use to change the
font.

Font Size Opens the Font Size list, which you can use to change
the numeric value for the font size.

Font Color Opens the Color dialog box, where you can select the
font color.

Style Reset Resets all settings to the default settings from the
template.

Bold Applies bold font formatting to the selected text.

Italic Applies italic font formatting to the selected text.

Underline Underlines the selected text.

Justify Left Aligns the text to the left of the visual.

Justify Center

Aligns the text to the center of the visual.

Justify Right

Aligns the text to the right of the visual.

Background Color

Opens the Color dialog box, where you can select the
background color for the visual.

Data Style Styles only the data for the selected data source field.

Title Style Styles only the column title for the selected data source
field.

Data + Title Styles both the data and the column title for the selected

data source field.

Format Group

Note: The options in this group are only available for reports in Document mode.

Change currency options

Changes the currency options for the selected field.

Percent

Specifies the value of the field as a percentage.
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Command

Description

Comma

Specifies the use of commas for the selected field.

Increase Decimal Places

Increases the number of decimal places that display for
the selected field.

Decrease Decimal Places

Decreases the number of decimal places that display for
the selected field.

Display Group

Hide Field Allows you to hide a selected field.

Hide Missing Allows you to hide fields that have no value.
Aggregation Opens a drop-down menu of the following options: None

(default), Sum, Average, Count, Count Distinct, Percent
of Count, First Value, Last Value, Maximum, Minimum,
Total, Percent, Row Percent, Median, Average Square.

Traffic Lights

Opens the Traffic Light Condition dialog box. From this
dialog box, you can add new conditional styling by
applying traffic light (and other) colors to a selected field
in the output when the field meets specified criteria,
modify existing conditional styling, and enable conditional
drill-down.

Within Allows you to use specific aggregation tasks at different
report levels. You can use the Within phrase to
manipulate display field values as they are aggregated
within a sort group rather than a report column.

Data Bars Adds a data visualization column to the right of a

selected numeric field. The column displays values in
each row using horizontal bars that extend from left to
right in varying lengths, depending on the corresponding
data values.
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Series Tab
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Command Description

Column(s) Allows you to indicate the number of columns in which
you wish to display multiple graphs. The value can be
between 1 and 512. The default is 1. This option is also
available from the Query Design pane shortcut menu for
a Multi-graph component.

Links Group

Drill Down Opens the Drill Down dialog box, where you can configure

a hyperlink or a drill-down procedure for the selected
field. Clicking that field in the report output, at run time,
redirects you to the URL you specified or executes the
indicated procedure. This option is disabled in Document
mode.

In Document mode, the Series tab is enabled for chart components.

Command

Description

Select Group

Series drop-down list

Lists the available series in the current chart.

Style Group

Style

Opens the Format Series dialog box, where you can edit
the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group
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Command

Description

Data Labels

Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Clicking More Data Label Options opens the Format
Labels dialog box, where you can further edit your data
labels.

Trendline

Opens a drop-down menu that provides options for
adding a trendline to a chart.

Equation

Displays the associated mathematical equation for a
trendline on a chart.

Line Group

Smooth Line

Draws the chart using smooth lines.

Connect Lines

Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.

Marker Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see Change the Appearance of a Marker.

Pie group

Note: The following options are only enabled when you are working with a pie chart.

Expand

Expands pie slices.

Hide

Hides pie slices.
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Ribbon Commands for Visualizations

When creating and customizing visualizations in Visualizations mode, you can use the following
ribbons and commands to customize visualization functionality.

Home Tab

Command Description

Clipboard Group

Paste Enables you to paste a text, report, or chart object that
you have copied to or placed on the clipboard.

Cut Enables you to cut a text, report, or chart object from
your document, placing it on the clipboard.

Copy Enables you to copy a text, report, or chart object to the
clipboard.
Duplicate Enables you to duplicate a text, report, or chart object in

your document, placing it on the clipboard.

Data Group

Calculation Opens a menu from which you can choose to create
Define or Compute fields.

Join Opens the Join dialog box, where you can create a new

join, edit or delete existing joins, and add data sources
to a join. You can also create blends, which allow you to
combine data from local or system resources into your
current data source.

Visual Group

Insert Inserts a new visual. The left side of the Insert button
inserts the default visual, which is a stacked bar chart.
Click the down arrow next to the Insert button to specify
a visual type, such as a chart, grid, or text.
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Command

Description

Change

Opens the Select a Visual menu, from which you can
select the type of chart, map, or grid that you want to
add to your visualization.

Swap

Changes the vertical or horizontal orientation of data in a
visual. When you add one or more fields to the canvas,
Swap is enabled. When you have data fields in the
vertical and horizontal field containers, clicking Swap
switches the axis of these data fields to display on the
opposite axis. When working with matrix charts, the rows
and columns are similarly switched when you click Swap.
Swap is available for bar, line, area, scatter, bubble, and
matrix marker charts. It is also available for grids.

Note:
-l Swap is disabled when the canvas is empty.

.d Swap is unavailable for maps.

Clear

Clears the current visual. You can use the split button to
select the option to clear a component, or the entire
visualization, which clears all visuals on the canvas. If
you have created a filter, you can also clear it. The Clear
button is disabled until you begin developing a visual on
the canvas.

Storyboard Group

Add Takes a snapshot of the current visual or visualization,
adding it to the storyboard.
Show Opens your storyboard as a PowerPoint presentation,

where you can choose to view or save your storyboard.
All storyboards display in Microsoft PowerPoint format.
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Format Tab
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Command

Description

Report Group

Theme

Opens the Templates dialog box, where you can select a
theme to style your grid. You can use the default style
sheet by clicking the Use Default Stylesheet button.

You can also select a styling theme for your grid or an
application theme to style all visualizations created.

Header & Footer

Opens the Header & Footer dialog box, from which you
can add and style headings and footings.

Column Totals

Adds a grand total row to the bottom of the grid object to
sum numeric data in each column.

Row Totals

This option is not supported in Visualization mode.

Features Group

Note: These options do not display for grids or maps, with the exception of Frame &

Background.

Reference

Opens the reference menu, where you can access the
Add Reference Line to Y-Axis and Add Reference Line to
X-Axis options. Selecting one of these options opens the
Reference Line dialog box, where you can set the
following: the X-axis or Y-axis value, the text that you
want to appear, and the position of the reference line on
a chart.

Grid

Opens the grid menu, where you can access the
Horizontal or Vertical Gridlines options. Both selections
allow you to enable or disable Major and Minor Gridlines.
Clicking More Grid Lines Options opens the Format Grid
Lines dialog box.
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Command

Description

Frame & Background

Opens the Frame & Background dialog box, where you
can edit the background style and frames for charts. This
dialog box contains different options depending on the
chart type that you have selected.

Labels Group

Axes

Opens the Axes menu, where you can enable and rotate
horizontal and vertical axis labels, as well as stagger
horizontal axis labels. You can also edit the axis labels
by clicking More Vertical Axis Options or More Horizontal
Axis Options. This option does not display for grids or
maps.

Legend

Opens the Legend menu, where you can select the Show
Legend option to display the legend on the chart. You
can also clear your selection to hide the legend. In
addition, you can change the default legend position and
orientation. This option displays for maps but does not
display for grids.

Interactive Group

Note: These options do not display for grids or maps.

Interactive Options

Opens the Interactive Options dialog box, which enables
you to specify animation and mouse over effects in your
chart.

View Tab

Command

Description

Show/Hide Group
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Field Tab
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Command

Description

Resources

Minimizes the Resources panel, expanding the size of
the canvas to occupy the area where the Resources
panel typically appears. When you click the Resources
button again, the Resources panel displays and the
chart, map, or grid adjusts accordingly.

Data Panel Group

Logical

Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

List

Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Structured

Displays the hierarchical structure of the data source
files. The Structured view options include Title,
Description, Field, and Alias.

Report Group

Switch Report

Lists any active report or chart to which you can switch.

Command

Description

Filter Group

Note: Options on the Field tab are

contingent on the visual type that you select.

Filter

Opens the Filter dialog box for creating filters. Filters
enable you to select only the data that you want and to
exclude unwanted data.
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Command Description

Exclude Select an existing filter in the Filter pane and choose
Exclude to remove, but not delete, the filter from the
visual.

Include Select an existing filter in the Filter pane and choose
Include to restore the filter, which was previously
excluded from the visual.

Sort Group

Up Displays the data source fields by type. This is the
default view. The Logical view options include Title,
Description, Field, and Alias.

Down Displays the data source fields in a tabular list format.
This list contains a header row. You can sort fields
differently by clicking a column header. The List view
options include Title, Description, Field, Alias, Format,
Segment, Filename, and Reference.

Group Opens the Create a Group dialog box where you can
create a group to combine values together. For grids, this
option is activated when you select a dimension.

Display Group

Hide Field Hides a selected field.

Aggregation Specifies an aggregation for a specific field. Commonly

used options include: Sum, Average, Count, Minimum,
and Maximum.

Traffic Lights

Specifies conditional styling to the selected field.
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Series Tab

Command

Description

Select Group

Note: This group is not available for grids. For maps, this group is disabled.

Series drop-down list

Lists the available series in the current visualization.

Style Group

Style

Opens the Format Series dialog box, where you can edit
the styling options for the selected series. You can also
open this dialog box by right-clicking a series, and then
clicking More Style Options.

Properties Group

Data Labels

Adds data labels to the chart. The drop-down menu
contains the following data position options for selecting
where to display data values as labels on a chart: Above
(default), On top edge, Below top edge, Center, and
Base. If you are working with a Pie chart, the options are:
On Slice, Outside Slice, and Outside with feeler lines.

Type

Opens a drop-down menu with the following options for
selecting different chart types: None (default), Bar, Line,
and Area.

Trendline

Opens a drop-down menu that provides options for
adding a trendline to a chart.

Line Group

Smooth Line

Draws the chart using smooth lines.

Connect Lines

Controls the display of connecting lines between markers
on a line or scatter chart. By default, lines are connected
on a line chart and disconnected on a scatter chart.
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Command

Description

Marker

Opens a drop-down menu from which you can select
options to change the display of the default data and
legend markers on line and scatter chart types. For more
information, see Change the Appearance of a Marker.

Pie Group

Note: The following options are only enabled when you are working with a pie chart.

Expand

Expands pie slices.

Hide

Hides pie slices.
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Chapter

Understanding Warning Messages in
InfoAssist+

This topic describes InfoAssist+ warning messages.

In this chapter:

d InfoAssist+ Warning Messages

.4 Unsupported Syntax and Objects

InfoAssist+ Warning Messages

Message

Description

OK

Cancel

Are you sure you want to switch
data source? Doing so will
delete your current report.

This warning message
displays when a report
is first saved in a
different format and
one or more additional
reports are created
and saved, and the
user clicks Switch on
the Data tab and
selects a different
report from the
shortcut menu.

Deletes the
current
report.

Preserves the
current report.

Are you sure you want to add a
data source? Doing so will
delete your current report.

This warning message
displays when a report
is first saved in a
different format and
an additional report is
created and saved,
and Add on the Data
tab is selected.

Deletes the
current
report.

Preserves the
current report.
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Message

Description

OK

Cancel

Output to Printer syntax found.
This feature is not supported.
Your report will be converted to
PDF output.

This warning message
displays when opening
a procedure created in
HTML Graph Assistant
when certain criteria
are met.

Converts the
report to PDF
format.

Aborts the
process of
opening the
procedure.

Unsupported Graph Applet
syntax found. Your report will
be converted to use server-side
graphics.

As of Web Query
2.1.0, Graph Applet
functionality is no
longer supported. This
warning message
displays when opening
a procedure that
contains Graph Applet
syntax.

Converts
your report to
use server-
side
graphics.

Aborts the
process of
opening the
procedure.

Unsupported OLD graph engine
syntax found. Your report will
be converted to use NEW graph
engine syntax.

As of Web Query
2.1.0, OLD graph
engine functionality is
no longer supported.
This warning message
displays when opening
existing procedures
with OLD graph engine
syntax, informing the
user that unsupported
syntax was detected
and that the
procedure will be
converted to use NEW
graph engine syntax.

Converts the
procedure
from the OLD
graph engine
to the NEW
graph
engine.

No changes
are made to
the original
procedure and
it is closed.

Unsupported chart type syntax
found. Your report will be
converted to use the default
chart type.

This warning message
displays when opening
an existing procedure,
and certain criteria
have been met.

Converts the
report to use
the default
chart type.

Cancels the
conversion of
the report to
the default
chart type.
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Message Description OK Cancel
User Selection in this request This warning message | Converts the No changes
is not allowed with your displays when the report to use are made to
configuration. Your report will user selection option the default the original
be converted to default output. is not available on output type. procedure and
restore, or when you it is closed.
are restoring a user
selection option when
it is disabled at global
preference.
File Was Modified Outside of This warning message | Proceeds to Closes the
InfoAssist+. Continue? displays when there is | open the warning
any modification done modified message and
to an InfoAssist+ procedure in returns to the
report in the text InfoAssist+. WebFOCUS
editor. Home Page.

Unsupported Syntax and Objects

This section describes the syntax and objects that are not supported.

.d SUB-TOTAL syntax is not supported. If you try to open an existing procedure in InfoAssist+
from a legacy tool that contains SUB-TOTAL syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert the syntax to
SUBTOTAL and add the converted syntax to all higher level sort breaks.

d SUMMARIZE syntax is not supported. If you try to open an existing procedure in InfoAssist+
from a legacy tool that contains SUMMARIZE syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert the syntax to

RECOMPUTE.

.d HTML FULL, FIXED, and PAGED syntax is not supported. If you try to open an existing
procedure in InfoAssist+ from a legacy tool that contains any of these three options, an
unsupported syntax warning message displays. If you choose to continue, InfoAssist+ will
convert the procedure to regular HTML output.
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- COLUMN-TOTAL syntax is not supported. If you try to open an existing procedure in
InfoAssist+ from a legacy tool that contains this syntax, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will convert it to use RECOMPUTE
syntax.

. Line objects in a compound document imported from a legacy tool are not supported. If you
try to open an existing procedure that includes line objects, an unsupported syntax warning
message displays. If you choose to continue, InfoAssist+ will remove these line objects.
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Glossary

3D Effect

Accessibility

Accordion

accordion report

active chart

active dashboard

active dashboard prompts

active dashboard
properties dialog

active PDF

Db2 Web Query InfoAssist+ Part 2

A customized charting feature that sets the three-dimensional view
to be on or off.

A specialized reporting feature that allows a title to be added to a
report, chart, or document that is Section 508 compliant. This
option is only available for reports and charts when the output type
is HTML or PDF.

A specialized reporting feature in which expandable views of data
are created for each vertical sort field. This option displays data
values only for the first vertical sort field when the user first views
the output. The view can be expanded manually to expose the data
values of lower-level sort fields.

Report output that is expandable for each vertical sort field.

A chart that uses the full capabilities of Active Technologies.

A dashboard that uses the full capabilities of Active Technologies.

Controls from Active Technologies that act as filters on the reports
of the document, such as text box, image, drop down, list, check
box, radio button, and text field.

A dialog box of options to add active form controls to reports in a
document.

An output format available for reports, charts, documents, and
dashboards. Requires Adobe® Reader® 9.0 or later.
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active report

active report Options

Aggregation

aggregation value

Annotate

annotation

application button

axis

axis labels

axis title

172

A report that uses the full capabilities of Active Technologies.

A customized charting feature. Opens the active report options
dialog box where you can configure your active report options, such
as menu items, graph engine, and colors. This option is only
available when the output type is set to active report or active PDF.

A report custom feature in which the user can display numeric
measure data using a variety of aggregation options other than the
default of Sum.

A value assigned to a numeric measure field in a report.

A customized charting feature that allows the user to add an
annotation and position it on a chart.

Explanatory note or comment.

A button on the InfoAssist+ Application window that provides
access to the application menu of procedure-related commands.

A reference line drawn on a chart.

Labels generated automatically based upon the scale of the axis.
They appear along the axis.

Descriptive text that provides meaningful information about the
data measured by an axis.
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background

canvas

cascade

cascade controls

cell padding

color bands

color mode

data bars

Db2 Web Query InfoAssist+ Part 2

The area that appears behind the frame of a chart.

A component of the InfoAssist+ application window. The canvas
displays a preview of the report being created or modified on the
canvas when the user is in Live Preview (default). The canvas is
always fully maximized and cannot be minimized, cascaded, or
tiled. A blank canvas opens when there is no report.

An output view option in which multiple output windows are
cascaded diagonally across the canvas.

Controls that have a parent-child relationship, in which the parent
filters the available options of the child. An active form control can
be the parent of more than one other control, but cannot be a child
of more than one control.

The amount of space inserted between rows and columns in a
report.

Basic design elements of a chart. Color bands come in a pair, with
each band uniquely colored. They appear in a continually repeating
pattern behind a series on a chart. The contrast of colors is
designed to make a chart easier to read.

The mode that controls how color is applied to a series (measure
field) on a chart. The possible settings are By Series (default) and
By Group.

A report custom feature in which data visualization bars are added
to numeric data.
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174

data labels

Data tab

Demographic Layers

dimension filtering

document theme

Environment and Styling

feeler line

Field tab

Descriptive names that identify specific data points within a series.

A tab on the ribbon that contains data manipulation and data
display options in the Calculation, Join, Filter, Display, and Data
Source groups.

Display a layer of information about people and businesses in a
specific demographic area. This includes the United States and
120 other countries. Demographic Layers are thematic maps that
provide additional information about the location, such as spending
habits, population, and lifestyles.

An option to display dimension filters at the top of a report.

A theme selected by the user to distinctly style reports and charts.

Area of the InfoAssist+ Options window that contains settings to
select an application theme for the user interface or a document
theme to apply styling to reports and charts.

A line that connects the data label to a chart.

A tab on the ribbon that appears when the user selects a data
source field in the Query pane or the canvas. The options available
in the Field tab are specific to the data type that is selected. The
options available for numeric fields are different from the options
available for non-numeric and date fields. The Field tab provides
access to the Filter, Sort, Break, Style, Format, Display, and Links
groups.
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Filter pane

Format Axis dialog box

Format Gauge dialog box

Format Grid Lines dialog
box

Format Labels dialog box

Format Series dialog box

Format tab

frame
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A component of the Resources panel that is located under the Data
pane. You can drag fields from the Data pane to the Filter pane to
filter your report. You can also manage filters in the Filter pane.

A dialog box of options for formatting for both vertical and horizontal
axes.

A dialog box of options for formatting a gauge chart. Such options
include setting and styling a title for the gauge chart, setting tick
marks, and color bands, as well as advanced settings, such as
setting the gauge start and stop angle.

A dialog box of options to format horizontal and vertical gridlines,
color bands, and frames on a chart.

A dialog box that contains options for editing data labels.

A dialog box that contains options to format the fill and border of
each series on a chart.

A tab on the ribbon that contains different options for selecting
output formats and other reporting features, depending on whether
you are creating a report. For reports, the Format tab provides
access to the Destination, Navigation, and Feature groups.

The area of a chart that contains all of the basic chart elements,
such as the plot points, gridlines, legend, and chart title. The frame
appears as a rectangle.
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Frame & Background

Freeze

gauges

grid

gridlines

Home tab

InfoMini

Insert tab
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A customized charting feature. Through the Frame & Background
dialog box, the user can set frame and background options specific
to the chart type selected.

A custom report output format that allows the user to view output
with column titles that freeze (remain in view) when the user scrolls
through pages of the report output.

A customized charting feature. Through the Gauge dialog box the
user can set options specific to a gauge chart.

A customized charting feature that allows the user to set options
for horizontal and vertical gridlines.

Lines that run horizontally and vertically to enhance the readability
of a chart. Gridlines can be major or minor.

A tab on the ribbon that contains the most commonly-used
commands and options from the Format, Design, Filter, and Report
groups.

An application built from an InfoAssist+ report that contains a
subset of InfoAssist+ functionality at run time.

A tab on the ribbon that contains options to add reports, charts,
existing reports, text, images, and active form control (for active
report, and active PDF outputs only) to a canvas in Document
mode.
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Interface theme

Layout tab

legend

Lightweight Mapping

limit

markers

Navigation taskbar

Page Breaks
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A theme selected by the user to style all menus and dialog boxes.

A tab on the ribbon that provides access to page display and layout
options from the Page setup, Size & Arrange, and Report groups.

A chart element that displays each series that appears on a chart.

The Lightweight Mapping functionality offers the ability to view data
that is bound to a geo-location. Using a powerful HTML5 map
viewer, you can view data using a variety of popular formats, such
as bubble markers and heat filled polygons (also known as
choropleths). The HTML5 map viewer contains zoom, pan, and
scale controls. You can use this functionality to visualize patterns,
trends, and relationships related to the location information in data.

A report custom feature in which the number of unique variables in
a column is limited.

Visual elements found on line charts that represent data points on
a chart.

A component of the InfoAssist+ Application window that displays
groups and icons that provides different views and quick access to
all active reports and report access.

A custom report Pages on Demand feature in which a new page is
started in the output when the primary sort field changes.
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178

Pages On Demand

Pop-up Title

quadrant lines

Query pane

Quick Access Toolbar

Rank

Recompute

Reference

Reference Layers

A custom report output format that allows the user to view output,
one page at a time, and to use a menu bar at the bottom of the
report output, from which the user can view a specific page.

A report custom feature in which pop-up titles are added to a report
and appear when the mouse pointer hovers over a column title.

Horizontal and vertical lines that cross to divide a chart into four
sections.

The Query pane is located at the bottom of the Resources panel. It
contains the field containers that hold the data fields that you
select.

A toolbar on the InfoAssist+ Application window that displays
frequently used commands, such as New, Open, save, Undo, Redo,
View code, Run, and Preview.

A report custom feature in which a ranking column is inserted for By
and Measure fields in a report.

A report custom feature in which the result of a Compute command
is recalculated.

A customized charting feature that allows the user to add a
reference line to the Y-axis and a reference line to the X-axis.

Display a layer of boundaries and locations that range from a
continental scale to country, state, and even local neighborhood.
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reference line

Repeat Sort Values

Resources panel

ribbon

ring label

Rotate

Row Totals

series

Series tab
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A line designed to draw attention to specific data locations on a
chart. A maximum of three horizontal (X axis) and three vertical (Y
axis) reference lines can be added to a chart.

A report custom feature in which all repeated sort values appear
instead of blanks after the first instance of a new sort value
appears in the report.

A panel that is comprised of the Data pane, the Filter pane, and the
Query pane.

A component of the InfoAssist+ Application window that displays
commands needed to create reports, charts, documents, and
dashboards.

Descriptive name for a concentric ring found on a ring chart.

A customized charting feature that allows the user to toggle
between a vertical or horizontal display of a chart.

A report custom feature in which a grand total column is inserted to
the right side of the report to sum numeric data in each row.

A group of data points that are plotted on a chart

A tab on the ribbon that only appears when the user is working with
charts. It provides access to chart options through the Select,
Properties, Line, Pie, and Display groups.
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180

slicers

Slicers tab

Stack Measures

splash screen

Status bar

Sub Footer

Sub Header

Subtotal

switch output

Dynamic filters that you can use with reports, charts, documents,
and dashboards.

A tab on the ribbon that provides the ability to create and edit
slicers.

An option to stack all measure fields on a report.

A screen of available Getting Started and Help options that opens
when a user clicks New on the InfoAssist+ application main menu.

A component of the InfoAssist+ Application window that contains
an output button that the user clicks to see the selected format
and an output target button that the user clicks to view the
selected option for displaying new output windows or tabs.

A report custom feature, in which a subfooting is added at the end
of the data on each page of the report output when the primary sort
field changes.

A report custom feature in which a subheading added just below
the column titles in the report output when the primary sort field
changes.

A report custom feature in which a subtotal is inserted in the output
for all numeric fields when the primary sort field changes.

An output view option in which a drop-down menu opens, where the
user can select any active report to view the output.
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Table of Contents

tile horizontally

tile vertically

Title Popup

traffic light conditional
styling

trendline

View

View tab
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A custom report output format that allows the user to view output
for individual values of the first sort (By) field, one value at a time.

An output view option in which multiple output windows are tiled
horizontally, one above another, across the canvas.

An output view option in which multiple output windows are tiled
vertically, side by side, across the canvas.

A specialized reporting feature in which a pop-up title appears when
the mouse pointer hovers over a column title in the report output.

Color styling applied to data for a selected measure field. By
default a report displays the values that satisfy the first condition in
green, and the values that satisfy the second condition in red.

A line drawn between any two points on a data series that shows
the direction that the values of the data series are going in.

Area of the InfoAssist+ Options window that provides settings for
establishing the design view in which the user will work, the type of
data that the user will use when previewing output, the limit that
needs to be set on record input, how data and query panels will
look, and the output target that will be used.

A tab on the ribbon that provides access to report design viewing
options in the Design, Show/Hide, Data Panel, Query Panel, Output
Window, and Reports groups.
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Within Functionality that allows you to use specific aggregation tasks at
different report levels. You can use the Within phrase to manipulate
display field values as they are aggregated within a sort group
rather than a report column.
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